Copyright and Trademark Information

© 2013 SAS IP, Inc. All rights reserved. Unauthorized use, distribution or duplication is prohibited.

ANSYS, ANSYS Workbench, Ansoft, AUTODYN, EKM, Engineering Knowledge Manager, CFX, FLUENT, HFSS and any and all ANSYS, Inc. brand, product, service and feature names, logos and slogans are registered trademarks or trademarks of ANSYS, Inc. or its subsidiaries in the United States or other countries. ICEM CFD is a trademark used by ANSYS, Inc. under license. CFX is a trademark of Sony Corporation in Japan. All other brand, product, service and feature names or trademarks are the property of their respective owners.

Disclaimer Notice

THIS ANSYS SOFTWARE PRODUCT AND PROGRAM DOCUMENTATION INCLUDE TRADE SECRETS AND ARE CONFIDENTIAL AND PROPRIETARY PRODUCTS OF ANSYS, INC., ITS SUBSIDIARIES, OR LICENSORS. The software products and documentation are furnished by ANSYS, Inc., its subsidiaries, or affiliates under a software license agreement that contains provisions concerning non-disclosure, copying, length and nature of use, compliance with exporting laws, warranties, disclaimers, limitations of liability, and remedies, and other provisions. The software products and documentation may be used, disclosed, transferred, or copied only in accordance with the terms and conditions of that software license agreement.

ANSYS, Inc. is certified to ISO 9001:2008.

U.S. Government Rights

For U.S. Government users, except as specifically granted by the ANSYS, Inc. software license agreement, the use, duplication, or disclosure by the United States Government is subject to restrictions stated in the ANSYS, Inc. software license agreement and FAR 12.212 (for non-DOD licenses).

Third-Party Software

See the legal information in the product help files for the complete Legal Notice for ANSYS proprietary software and third-party software. If you are unable to access the Legal Notice, please contact ANSYS, Inc.

Published in the U.S.A.
# Table of Contents

## 1. Computational Fluid Dynamics

1.1. The History of CFD ........................................... 1

1.2. The Mathematics of CFD ........................................... 1

1.3. Uses of CFD ................................................... 2

1.4. CFD Methodology ................................................... 2

1.4.1. Creating the Geometry/Mesh ................................................... 4

1.4.2. Defining the Physics of the Model ................................................... 4

1.4.3. Solving the CFD Problem ........................................... 5

1.4.4. Visualizing the Results in the Post-processor ................................................... 5

1.5. Further Background Reading ................................................... 5

## 2. Overview of ANSYS CFX

2.1. The Structure of ANSYS CFX ........................................... 7

2.1.1. CFX-Pre ........................................... 8

2.1.2. CFX-Solver ........................................... 8

2.1.3. CFX-Solver Manager ........................................... 9

2.1.4. CFD-Post ........................................... 9

2.2. Running ANSYS CFX ........................................... 9

2.2.1. Valid Syntax in ANSYS CFX ........................................... 10

2.3. The Directory Structure of ANSYS CFX ........................................... 10

2.4. ANSYS CFX File Types ........................................... 11

2.5. Starting ANSYS CFX Components from the Command Line ........................................... 12

2.5.1. Obtaining System Information with the cfx5info Command ........................................... 13

## 3. Customizing ANSYS CFX

3.1. ANSYS CFX Resource Configuration Files ........................................... 15

3.1.1. The Site-wide Configuration Files ........................................... 15

3.1.2. User’s Configuration Files ........................................... 15

3.1.3. Syntax of CFX Resource Configuration Files ........................................... 16

3.1.3.1. Resource Names ........................................... 16

3.1.4. Resources Set in cfx5rc Files ........................................... 17

3.1.4.1. Setting Environment Variables ........................................... 18

## 4. Using the ANSYS CFX Launcher

4.1. Starting the ANSYS CFX Launcher ........................................... 19

## 5. ANSYS CFX in ANSYS Workbench

5.1. The ANSYS Workbench Interface ........................................... 21

5.1.1. Toolbox ........................................... 22

5.1.2. Project Schematic ........................................... 23

5.1.3. Workspace Tabs ........................................... 24

5.1.4. View Bar ........................................... 24

5.1.5. Properties View ........................................... 25

5.1.5.1. Resolving Execution Control Conflicts ........................................... 27

5.1.6. Resolving a 2-Way FSI Error ........................................... 28

5.1.7. Files View ........................................... 28

5.1.7.1. ANSYS CFX Files in ANSYS Workbench ........................................... 28

5.1.8. Sidebar Help ........................................... 29

5.1.9. Shortcuts (Context Menu Options) ........................................... 29

5.1.10. File Operation Differences ........................................... 30

5.2. An Introduction to Workflow in ANSYS Workbench ........................................... 31

5.2.1. Using RIF Generation in CFX-Pre in ANSYS Workbench ........................................... 34

5.2.2. Data Flow in Systems and Between Systems ........................................... 34

5.3. Design Exploration Interface ........................................... 35
6. Help On Help

6.1. Document Conventions
6.1.1. Spelling Conventions
6.1.2. File and Directory Names
6.1.3. Optional Arguments
6.1.4. ANSYS Workbench Preferences: Named Selections
6.1.5. Mesh Modifications in CFX-Pre in ANSYS Workbench
6.1.6. Loading .cmdb Files
6.1.7. ANSYS Workbench Connections

6.2. Accessing Help
6.2.1. Acquiring a Journal File with ANSYS CFX
6.2.2. Editing a Journal File (Scripting)
6.2.3. Limitations to Scripting Actions with ANSYS CFX Applications

5.4. Using ANSYS Workbench Journaling and Scripting with ANSYS CFX
5.4.1. Acquiring a Journal File with ANSYS CFX in ANSYS Workbench
5.4.1.1. Journal of an Operation That Uses CFX-Pre
5.4.1.2. Journal of an Operation That Uses CFX-Solver Manager
5.4.1.3. Journal of an Operation That Creates a Plane in CFD-Post
5.4.2. Editing a Journal File (Scripting)
5.4.2.1. Example: Using a Script to Change the Turbulence Setting in a Setup Cell
5.4.2.2. Example: Using a Script to Change an Existing Locator in a Results Cell
5.4.3. Limitations to Scripting Actions with ANSYS CFX Applications

5.5. Archiving ANSYS CFX Projects

5.6. Using Remote Solve Manager with ANSYS CFX
5.6.1. Configuring CFX over Remote Solve Manager
5.6.2. Limitations When Using Remote Solve Manager with ANSYS CFX

5.7. ANSYS CFX Tutorials and ANSYS Workbench

5.8. Tips on Using ANSYS Workbench
5.8.1. General Tips
5.8.1.1. ANSYS Workbench Interface
5.8.1.2. Setting Units
5.8.1.3. Files View
5.8.1.4. ANSYS Workbench Preferences: Named Selections
5.8.1.5. Mesh Modifications in CFX-Pre in ANSYS Workbench
5.8.1.6. Loading .cmdb Files
5.8.1.7. ANSYS Workbench Connections

5.8.2. Tips for CFX/Fluid Flow Systems
5.8.2.1. Changes in Behavior
5.8.2.2. Duplicating Systems
5.8.2.3. Renaming Systems
5.8.2.4. Updating Cells
5.8.2.5. Setup Cell
5.8.2.6. Solution Cell
5.8.2.7. Results Cell
5.8.2.8. Recovering After Deleting Files
5.8.2.9. Backwards Compatibility When ANSYS CFX Files Exist in the Original Project
5.8.2.10. License Sharing

5.8.3. Tips for Parameters and Design Exploration
5.8.3.1. Saving Files/Exported Design Points
5.8.3.2. Number of Design Points
5.8.3.3. Obtaining Solutions for Design Points
5.8.3.4. The CFX-Solver Background Mode
5.8.3.5. Known Limitations of ANSYS CFX Running in ANSYS Workbench

6. Help On Help

6.1. Document Conventions
6.1.1. Spelling Conventions
6.1.2. File and Directory Names
6.1.3. Optional Arguments
6.1.4. Long Commands
6.1.5. Operating System Names

6.2. Accessing Help

6.3. Using the Search Feature

7. Contact Information
Chapter 1: Computational Fluid Dynamics

Computational Fluid Dynamics (CFD) is a computer-based tool for simulating the behavior of systems involving fluid flow, heat transfer, and other related physical processes. It works by solving the equations of fluid flow (in a special form) over a region of interest, with specified (known) conditions on the boundary of that region.

This chapter discusses:
1.1. The History of CFD
1.2. The Mathematics of CFD
1.3. Uses of CFD
1.4. CFD Methodology
1.5. Further Background Reading

1.1. The History of CFD

Computers have been used to solve fluid flow problems for many years. Numerous programs have been written to solve either specific problems, or specific classes of problems. From the mid-1970s, the complex mathematics required to generalize the algorithms began to be understood, and general purpose CFD solvers were developed. These began to appear in the early 1980s and required what were then very powerful computers, as well as an in-depth knowledge of fluid dynamics, and large amounts of time to set up simulations. Consequently, CFD was a tool used almost exclusively in research.

Recent advances in computing power, together with powerful graphics and interactive 3D manipulation of models, have made the process of creating a CFD model and analyzing results much less labor intensive, reducing time and, hence, cost. Advanced solvers contain algorithms that enable robust solutions of the flow field in a reasonable time.

As a result of these factors, Computational Fluid Dynamics is now an established industrial design tool, helping to reduce design time scales and improve processes throughout the engineering world. CFD provides a cost-effective and accurate alternative to scale model testing, with variations on the simulation being performed quickly, offering obvious advantages.

1.2. The Mathematics of CFD

The set of equations that describe the processes of momentum, heat and mass transfer are known as the Navier-Stokes equations. These partial differential equations were derived in the early nineteenth century and have no known general analytical solution but can be discretized and solved numerically.

Equations describing other processes, such as combustion, can also be solved in conjunction with the Navier-Stokes equations. Often, an approximating model is used to derive these additional equations, turbulence models being a particularly important example.

There are a number of different solution methods that are used in CFD codes. The most common, and the one on which CFX is based, is known as the finite volume technique.
In this technique, the region of interest is divided into small sub-regions, called control volumes. The equations are discretized and solved iteratively for each control volume. As a result, an approximation of the value of each variable at specific points throughout the domain can be obtained. In this way, one derives a full picture of the behavior of the flow.

Additional information on the Navier-Stokes equations and other mathematical aspects of the CFX software suite is available in Basic Solver Capability Theory in the CFX-Solver Theory Guide.

1.3. Uses of CFD

CFD is used by engineers and scientists in a wide range of fields. Typical applications include:

- **Process industry**: Mixing vessels, chemical reactors
- **Building services**: Ventilation of buildings, such as atriums
- **Health and safety**: Investigating the effects of fire and smoke
- **Motor industry**: Combustion modeling, car aerodynamics
- **Electronics**: Heat transfer within and around circuit boards
- **Environmental**: Dispersion of pollutants in air or water
- **Power and energy**: Optimization of combustion processes
- **Medical**: Blood flow through grafted blood vessels

1.4. CFD Methodology

CFD can be used to determine the performance of a component at the design stage, or it can be used to analyze difficulties with an existing component and lead to its improved design.

For example, the pressure drop through a component may be considered excessive:
The first step is to identify the region of interest:

The geometry of the region of interest is then defined. If the geometry already exists in CAD, it can be imported directly. The mesh is then created. After importing the mesh into the pre-processor, other elements of the simulation including the boundary conditions (inlets, outlets, and so on) and fluid properties are defined.

The flow solver is run to produce a file of results that contains the variation of velocity, pressure and any other variables throughout the region of interest.

The results can be visualized and can provide the engineer an understanding of the behavior of the fluid throughout the region of interest.
This can lead to design modifications that can be tested by changing the geometry of the CFD model and seeing the effect.

The process of performing a single CFD simulation is split into four components:

1. Creating the Geometry/Mesh (p. 4)
2. Defining the Physics of the Model (p. 4)
3. Solving the CFD Problem (p. 5)
4. Visualizing the Results in the Post-processor (p. 5)

### 1.4.1. Creating the Geometry/Mesh

This interactive process is the first pre-processing stage. The objective is to produce a mesh for input to the physics pre-processor. Before a mesh can be produced, a closed geometric solid is required. The geometry and mesh can be created in the Meshing application or any of the other geometry/mesh creation tools. The basic steps involve:

1. Defining the geometry of the region of interest.
2. Creating regions of fluid flow, solid regions and surface boundary names.
3. Setting properties for the mesh.

This pre-processing stage is now highly automated. In CFX, geometry can be imported from most major CAD packages using native format, and the mesh of control volumes is generated automatically.

### 1.4.2. Defining the Physics of the Model

This interactive process is the second pre-processing stage and is used to create input required by the Solver. The mesh files are loaded into the physics pre-processor, CFX-Pre.
The physical models that are to be included in the simulation are selected. Fluid properties and boundary conditions are specified.

### 1.4.3. Solving the CFD Problem

The component that solves the CFD problem is called the Solver. It produces the required results in a non-interactive/batch process. A CFD problem is solved as follows:

1. The partial differential equations are integrated over all the control volumes in the region of interest. This is equivalent to applying a basic conservation law (for example, for mass or momentum) to each control volume.

2. These integral equations are converted to a system of algebraic equations by generating a set of approximations for the terms in the integral equations.

3. The algebraic equations are solved iteratively.

An iterative approach is required because of the nonlinear nature of the equations, and as the solution approaches the exact solution, it is said to converge. For each iteration, an error, or residual, is reported as a measure of the overall conservation of the flow properties.

How close the final solution is to the exact solution depends on a number of factors, including the size and shape of the control volumes and the size of the final residuals. Complex physical processes, such as combustion and turbulence, are often modeled using empirical relationships. The approximations inherent in these models also contribute to differences between the CFD solution and the real flow.

The solution process requires no user interaction and is, therefore, usually carried out as a batch process.

The solver produces a results file that is then passed to the post-processor.

### 1.4.4. Visualizing the Results in the Post-processor

The post-processor is the component used to analyze, visualize and present the results interactively. Post-processing includes anything from obtaining point values to complex animated sequences.

Examples of some important features of post-processors are:

- Visualization of the geometry and control volumes
- Vector plots showing the direction and magnitude of the flow
- Visualization of the variation of scalar variables (variables that have only magnitude, not direction, such as temperature, pressure and speed) through the domain
- Quantitative numerical calculations
- Animation
- Charts showing graphical plots of variables
- Hardcopy and online output.

### 1.5. Further Background Reading

The following is a selection of books related to fluids, thermodynamics, CFD and computing:
Computational Fluid Dynamics

- *An Introduction to Computational Fluid Dynamics, The Finite Volume Method*
  

- *Using Computational Fluid Dynamics*
  
  C T Shaw; Prentice Hall, 1992. An introduction to the practical aspects of using CFD.

- *Numerical Heat Transfer and Fluid Flow*
  

- *Engineering Thermodynamics: Work and Heat Transfer*
  

- *Mechanics of Fluids*
  

- *Viscous Fluid Flow*
  

- *Perry’s Chemical Engineer’s Handbook (7th Edition)*
  

- *An Album of Fluid Motion*
  
Chapter 2: Overview of ANSYS CFX

ANSYS CFX is a general purpose Computational Fluid Dynamics (CFD) software suite that combines an advanced solver with powerful pre- and post-processing capabilities. It includes the following features:

• An advanced coupled solver that is both reliable and robust.
• Full integration of problem definition, analysis, and results presentation.
• An intuitive and interactive setup process, using menus and advanced graphics.

ANSYS CFX is capable of modeling:
• Steady-state and transient flows
• Laminar and turbulent flows
• Subsonic, transonic and supersonic flows
• Heat transfer and thermal radiation
• Buoyancy
• Non-Newtonian flows
• Transport of non-reacting scalar components
• Multiphase flows
• Combustion
• Flows in multiple frames of reference
• Particle tracking.

This chapter discusses:
2.1. The Structure of ANSYS CFX
2.2. Running ANSYS CFX
2.3. The Directory Structure of ANSYS CFX
2.4. ANSYS CFX File Types
2.5. Starting ANSYS CFX Components from the Command Line

2.1. The Structure of ANSYS CFX

ANSYS CFX consists of four software modules that take a geometry and mesh and pass the information required to perform a CFD analysis:
ANSYS CFX File Types (p. 11) show the file types involved in this data flow.

### 2.1.1. CFX-Pre

The next-generation physics pre-processor, CFX-Pre, is used to define simulations.

Multiple meshes may be imported, allowing each section of complex geometries to use the most appropriate mesh.

Analyses, which consist of flow physics, boundary conditions, initial values, and solver parameters, are also specified. A full range of boundary conditions, including inlets, outlets and openings, together with boundary conditions for heat transfer models and periodicity, are all available in ANSYS CFX through CFX-Pre; for details, see CFX-Pre Basics in the CFX-Pre User's Guide.

Complex simulations are assembled from one or more configurations, each of which combines an analysis definition with other related tasks such as remeshing. Control over the configuration execution order and inter-configuration solution dependencies then facilitates the setup of relatively common simulations, such as those involving the initialization of a transient analysis using results from a steady-state analysis. Use of multiple configurations and control also facilitates the setup of increasingly complex simulations of, for example, performance curves for turbo-machines or internal combustion engines with evolving geometry and physics.

### 2.1.2. CFX-Solver

CFX-Solver solves all the solution variables for the simulation for the problem specification generated in CFX-Pre.
One of the most important features of ANSYS CFX is its use of a coupled solver, in which all the hydro-
dynamic equations are solved as a single system. The coupled solver is faster than the traditional se-
gregated solver and fewer iterations are required to obtain a converged flow solution.

Additional information on the CFX-Solver models is available; for details, see Basic Capabilities Modeling
in the CFX-Solver Modeling Guide.

2.1.3. CFX-Solver Manager

The CFX-Solver Manager module provides greater control to the management of the CFD task. Its major
functions are:

• Specify the input files to the CFX-Solver.

• Start/stop the CFX-Solver.

• Monitor the progress of the solution.

• Set up the CFX-Solver for a parallel calculation.

Additional information on the CFX-Solver Manager is available; for details, see CFX-Solver Manager Basics
in the CFX-Solver Manager User’s Guide.

2.1.4. CFD-Post

CFD-Post provides state-of-the-art interactive post-processing graphics tools to analyze and present the
ANSYS CFX simulation results.

Important features include:

• Quantitative post-processing

• Report generation (see Report in the CFD-Post User’s Guide)

• Command line, session file, or state file input (see File Types Used and Produced by CFD-Post in the CFD-
Post User’s Guide)

• User-defined variables

• Generation of a variety of graphical objects where visibility, transparency, color, and line/face rendering
can be controlled (see CFD-Post Insert Menu in the CFD-Post User’s Guide)

• Power Syntax to allow fully programmable session files (see Power Syntax in ANSYS CFX in the CFX Reference
Guide).

Additional information on CFD-Post is available; for details, see Overview of CFD-Post in the CFD-Post
User’s Guide.

2.2. Running ANSYS CFX

To run ANSYS CFX:
On this operating system: | Do this: 
--- | ---
**UNIX** | Enter `cfx5` in a terminal window.
**Windows** | From the **Start** menu select **All Programs > ANSYS 15.0 > Fluid Dynamics > CFX 15.0**.

This opens the ANSYS CFX Launcher, from which all other components of ANSYS CFX can be accessed. You will usually want to start by setting your Working Directory (where all files will be written to) and then opening CFX-Pre by clicking the **CFX-Pre 15.0** button. See Using the ANSYS CFX Launcher (p. 19) for more information about using the launcher.

---

**Note**

You can also start ANSYS components from the command line (Starting ANSYS CFX Components from the Command Line (p. 12)) or ANSYS Workbench (ANSYS CFX in ANSYS Workbench (p. 21)).

---

### 2.2.1. Valid Syntax in ANSYS CFX

#### Valid Syntax for Named Objects

The names of objects must be no more than 80 characters in length. Any of the following characters are allowed to name new objects: `A-Z a-z 0-9 <space>` (however, the first character must be `A-Z` or `a-z`). Multiple spaces are treated as single space characters, and spaces at the end of a name are ignored. In general, object names must be unique within the physics setup.

#### Valid Decimal Separator

In ANSYS CFX, only a period is allowed to be used decimal delimiters in fields that accept floating-point input. If your system is set to a European locale that uses a comma separator (such as Germany), fields that accept numeric input will accept a comma, but an error will be returned. If your system is set to a non-European locale, numeric fields will not accept a comma at all.

ANSYS Workbench accepts commas as decimal delimiters, but translates these to periods when passing data to ANSYS CFX.

#### Valid Network Path

UNC paths are not supported in ANSYS CFX. You should use drive letters when opening ANSYS CFX products over a network installation.

---

### 2.3. The Directory Structure of ANSYS CFX

In this documentation, `<CFXROOT>` refers to the path to your installation of ANSYS CFX, for example `C:\Program Files\Ansys Inc\V150\CFX` on Windows. The path to `<CFXROOT>` is release-specific to enable you to have more than one release of ANSYS CFX installed.

Some of the important directories immediately under `<CFXROOT>` are:

- **bin**
  - Contains executable programs for starting ANSYS CFX software components.
- **config**
  - Contains the host definition file for ANSYS CFX software.
- **etc**
  - Contains various data files common to all supported system types.
Contains files that will help you work through the ANSYS CFX tutorials. There are sample meshes, CAD files, session files, CFX Expression Language files, User Fortran examples, and example C source code files.

Contains header files used by parts of the ANSYS CFX software.

Contains libraries needed to relink the CFX-Solver for user-defined mesh import or mesh export.

Contains software tools such as cygwin, hpmpi, perl, pvm (Linux only), and qt.

2.4. ANSYS CFX File Types

During the process of creating the model, running the CFX-Solver and analyzing the results, a number of different files are created by the various modules of the software. This section describes some of these files and their purposes.

The use of these files with their default extension is shown in the following flowchart. The standard files used and produced are indicated with solid black lines; other possible uses are indicated with dotted lines.

Details of the main file types can be found in:

- CFX-Pre File Types in the CFX-Pre User's Guide
- CFX-Solver Files in the CFX-Solver Manager User's Guide
2.5. Starting ANSYS CFX Components from the Command Line

The components of ANSYS CFX can all be started from the command line. A command consists of the path to the command, the command name, and various arguments, many of which are optional.

For example, to start up CFX-Pre and play a session file named `StaticMixer.pre`, open a terminal window and enter the command:

```
<CFXROOT>/bin/cfx5pre -play StaticMixer.pre
```

where `<CFXROOT>` is the path to your installation of CFX, for example `C:\Program Files\Ansys Inc\V150\CFX` on Windows.

The following table lists some of the commands you can use to start ANSYS CFX components:

<table>
<thead>
<tr>
<th>Component</th>
<th>Command</th>
<th>Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSYS CFX Launcher</td>
<td>cfx5</td>
<td>See Starting the ANSYS CFX Launcher (p. 19).</td>
</tr>
<tr>
<td></td>
<td>or</td>
<td></td>
</tr>
<tr>
<td></td>
<td>cfx5launch</td>
<td></td>
</tr>
<tr>
<td>CFX-Pre</td>
<td>cfx5pre</td>
<td>See Starting CFX-Pre from the Command Line in the CFX-Pre User's Guide.</td>
</tr>
<tr>
<td>CFX-Solver Manager</td>
<td>cfx5solve</td>
<td>See Starting the CFX-Solver from the Command Line in the CFX-Solver Manager User's Guide.</td>
</tr>
<tr>
<td>CFD-Post</td>
<td>cfdpost</td>
<td>See Starting CFD-Post from the Command Line in the CFD-Post User's Guide.</td>
</tr>
</tbody>
</table>

**Tip**

- To display a full list of all the possible arguments and a short description for any command, type the command followed by `-help`. For example:

  ```
  cfdpost -help
  ```

- Typing the argument `-verbose` after a command launches the software specified and displays a summary of the currently set environment variables.

- ANSYS CFX Launcher provides a command line with a preset path to the ANSYS CFX executables. From the launcher, select Tools > Command Line. For details, see Command Line.

- You can append the path to the ANSYS CFX executables to your Windows PATH.

  1. Right-click My Computer and select Properties.
2. Click the **Advanced** tab.

3. Click **Environment Variables**.

4. In the **System variables** pane, select **Path** and click **Edit**.

5. Append the path to the ANSYS CFX executables to the **Variable value** field. For example:

   
   ```
   C:\Program Files\ANSYS Inc\v150\CFX\bin;
   ```

6. Click **OK** as required to set the new path and close the dialog boxes.

   • You can append the path to the ANSYS CFX executables to your UNIX search path.

---

### 2.5.1. Obtaining System Information with the cfx5info Command

You can use the command `cfx5info` to obtain information about your installation and your system. The optional command arguments are given in the following table:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Usage Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>–arch</code></td>
<td>Displays the long architecture string for the current machine.</td>
</tr>
<tr>
<td><code>–cmds</code></td>
<td>Prints the location of some common commands, if they can be found in the PATH.</td>
</tr>
<tr>
<td><code>–config</code></td>
<td>If any site-specific or user-specific configuration files are in use, this option will display their locations and contents.</td>
</tr>
<tr>
<td><code>–full</code></td>
<td>Displays a full report on the installation and configuration of ANSYS CFX, suitable for emailing to the ANSYS CFX Support desk. This includes the output of the <code>–inst</code> and <code>–system</code> options.</td>
</tr>
<tr>
<td><code>–host</code></td>
<td>Displays available command line options and descriptions.</td>
</tr>
<tr>
<td><code>–host-addr</code>&lt;host&gt;</td>
<td>Looks up the named <code>&lt;host&gt;</code> in the network database, and displays some information about it.</td>
</tr>
<tr>
<td><code>–inst</code></td>
<td>Displays the short architecture string for the current machine.</td>
</tr>
<tr>
<td><code>–os</code></td>
<td>Displays the release type, which will be “development,” “prerelease” or “release.”</td>
</tr>
<tr>
<td><code>–reltype</code></td>
<td>Displays information about which subsets are installed. This option is valid only for UNIX platforms.</td>
</tr>
<tr>
<td><code>–system</code></td>
<td>Displays the short architecture string for the current machine.</td>
</tr>
<tr>
<td><code>–system</code></td>
<td>Displays information about the system on which ANSYS CFX is running.</td>
</tr>
<tr>
<td><code>–verbose</code></td>
<td>Prints information about the environment variables that are currently set. The alternative form for this argument is <code>-v</code></td>
</tr>
<tr>
<td><code>–whereis</code>&lt;cmd&gt;</td>
<td>Displays all available versions of <code>&lt;cmd&gt;</code>, as found on the PATH. This option can be repeated.</td>
</tr>
</tbody>
</table>
Chapter 3: Customizing ANSYS CFX

This chapter discusses:

3.1. ANSYS CFX Resource Configuration Files

3.1. ANSYS CFX Resource Configuration Files

When ANSYS CFX starts up, it reads several resource configuration files. By creating your own local and site-wide configuration files, you can modify the behavior of ANSYS CFX to meet your needs. A common use for configuration files is to set the path to the license file or the license server.

3.1.1. The Site-wide Configuration Files

If you are accessing your ANSYS CFX files from a remote file system, your System Administrator may create site-wide resource configuration files. ANSYS CFX first looks for such files in the following order:

1. `<CFXROOT>/config/cfx5rc-<host>.txt`
2. `<CFXROOT>/config/cfx5rc-<arch>.txt`
3. `<CFXROOT>/config/cfx5rc-<os>.txt`
4. `<CFXROOT>/config/cfx5rc.txt`
5. `<CFXROOT>/config/cfx5rc-site.txt`

where:

• `host` is the hostname of the machine on which ANSYS CFX is running.
• `arch` is the architecture of the machine on which ANSYS CFX is running.
• `os` is the operating system of the machine on which ANSYS CFX is running.

You can find the value of `host`, `arch`, and `os` by selecting **Show > Show System** from the menu bar of the ANSYS CFX Launcher. On Windows, the value of `os` is `winnt`.

**Note**

Any resources set in these files will affect all users of ANSYS CFX, unless users override these variables in their personal user’s ANSYS CFX resource configuration files.

3.1.2. User’s Configuration Files

After searching for site-wide configuration files, ANSYS CFX looks for the following user’s configuration files:
• cfx5rc-<host>.txt
• cfx5rc-<arch>.txt
• cfx5rc-<os>.txt
• cfx5rc.txt

(and for the same files without .txt appended) in the following directories:

• On Windows: %USERPROFILE%\Application Data\CFX-5\15.0\ if it exists, otherwise
  %HOMEDRIVE%\%HOMEPATH%\.cfx\15.0\ where %USERPROFILE%, %HOMEDRIVE% and %HOMEPATH% are environment variables.

• On Linux: ~/.cfx/15.0/ and ~/.CFX/15.0/
  where ~ means your home directory (if you have one).

3.1.3. Syntax of CFX Resource Configuration Files

ANSYS CFX resource configuration files should consist only of:

• Lines beginning with # (which are comments).

• Variable assignments such as: CFX5EDITOR="textedit"

The right hand side of an assignment may include references to previously assigned variables by prefixing
the variable name with $; for example,

CFX5BROWSER="$CFX5EDITOR"

---

Note

In previous releases of ANSYS CFX, these files could contain arbitrary Bourne shell commands. These are no longer supported.

---

3.1.3.1. Resource Names

ANSYS CFX software makes use of variable names that start with the following strings:

• CFDS_
• CFX_
• CFX4
• CFX5
• CUE_

You must not set any variable of your own with a name beginning with these letters.
3.1.4. Resources Set in cfx5rc Files

You can find out which ANSYS CFX resources have been set by using the Show > Show Variables option from the menu bar of the ANSYS CFX Launcher. This displays a list of all the resources that have been set. Although you can change the values of most of the resources shown in this list, it is generally useful to change only a few of them. These few are described in the following table:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFX5BROWSER</td>
<td>Sets the program to use when browsing files in ANSYS CFX.</td>
</tr>
<tr>
<td></td>
<td>On Windows, the default browser is Notepad.</td>
</tr>
<tr>
<td></td>
<td>On Linux, the default value is system-dependent, but the Common Desktop Environment file browser, dtpad, is used if possible. The command must start its own X window, so if you wanted to use view, for example, you could only do so by setting CFX5BROWSER=&quot;xterm -e view&quot;</td>
</tr>
<tr>
<td>CFX5EDITOR</td>
<td>Sets the program to use when editing files in ANSYS CFX.</td>
</tr>
<tr>
<td></td>
<td>On Windows, the default editor is Notepad.</td>
</tr>
<tr>
<td></td>
<td>On Linux, the default value is system-dependent but the Common Desktop Environment file editor, dtpad, is used if possible. The command must start its own X window, so if you wanted to use vi, for example, you could only do so by setting CFX5EDITOR=&quot;xterm -e vi&quot;</td>
</tr>
<tr>
<td>CFX5XTERM</td>
<td>Creates a window to interact with the operating system.</td>
</tr>
<tr>
<td></td>
<td>On Windows, the default window is a Windows command prompt set up to run the ANSYS CFX commands.</td>
</tr>
<tr>
<td></td>
<td>On Linux, the default value is system-dependent but the Common Desktop Environment terminal emulator, dtterm, is used if possible.</td>
</tr>
<tr>
<td>CFX_FORMAT</td>
<td>If set to F, this command causes ANSYS CFX programs to write formatted CFX-Solver input and results files instead of binary files.</td>
</tr>
<tr>
<td></td>
<td>If set to U, then the files generated will be in binary format, but not compressed.</td>
</tr>
<tr>
<td></td>
<td>If not set, then the files generated will be binary and compressed. This is the default.</td>
</tr>
<tr>
<td>CFX_IMPORT_EXEC</td>
<td>Sets the name of the user-defined executable for CFX Volume Mesh Import.</td>
</tr>
<tr>
<td>ANSYSLMD_LICENSE_FILE</td>
<td>Can be used to identify a license server machine or license file. If set, this specification is used before any other license path information. See License Files Settings Precedence in the Installation and Licensing Documentation for precedence information.</td>
</tr>
<tr>
<td>Resource</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>The default port number assigned to ANSYS, Inc. is 1055. Therefore, if your server has the hostname alpha1 and the IP address of 10.3.1.69, you can identify the server to use as 1055@alpha1 or 1055@10.3.1.69.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The FLEXlm environment variable LM_LICENSE_FILE is not supported with the ANSYS, Inc. License Manager.</td>
</tr>
<tr>
<td>ANSYSLI_SERVERS</td>
<td>Used to identify the server machine for the Licensing Interconnect. Set to port@host. The default port is 2325. This setting takes precedence over settings specified in the ansys1md.ini file.</td>
</tr>
<tr>
<td>SHLIB_PATH</td>
<td>This is a colon-separated list of directories that will be searched to look for shared libraries on HP systems. If you have installed system libraries in directories that are not included in this list, then add them to it.</td>
</tr>
</tbody>
</table>

### 3.1.4.1. Setting Environment Variables

You should set the variables in your cfx5rc file. You must not create environment variables that start with CFX.
Chapter 4: Using the ANSYS CFX Launcher

CFX can be run in two modes:

- CFX stand-alone, which refers to CFX running as a stand-alone application independent of the ANSYS Workbench software
- CFX in Workbench, which refers to CFX running as a component inside of the ANSYS Workbench software. This is described in ANSYS CFX in ANSYS Workbench (p. 21).

ANSYS CFX stand-alone has the launcher, which makes it easy to run all the modules of CFX without having to use a command line. The launcher enables you to:

- Set the working directory for your simulation.
- Start CFX and ANSYS products.
- Access various other tools, including a command window that enables you to run other utilities.
- Access the online help and other useful information.
- Customize the behavior of the launcher to start your own applications.

The launcher automatically searches for installations of CFX and ANSYS products including the license manager. Depending on the application, the search includes common installation directories, directories pointed to by environment variables associated with CFX and ANSYS products, and the Windows registry. In the unlikely event that a product is not found, you can configure the launcher using steps outlined in Customizing the ANSYS CFX Launcher in the CFX Reference Guide.

This chapter discusses Starting the ANSYS CFX Launcher (p. 19). For more information about the launcher, see ANSYS CFX Launcher in the CFX Reference Guide.

4.1. Starting the ANSYS CFX Launcher

You can run the ANSYS CFX Launcher in any of the following ways:

- On Windows:
  - From the Start menu, select All Programs > ANSYS 15.0 > Fluid Dynamics > CFX 15.0.
  - In a DOS window that has its path set up correctly to run ANSYS CFX, enter: cfx5

    If the path has not been set, you need to type the full path to the cfx5 command; typically this is:

    C:\Program Files\Ansys Inc\V150\CFX\bin\cfx5.exe

- On Linux, open a terminal window that has its path set up to run ANSYS CFX and enter: cfx5
If the path has not been set, you need to type the full path to the cfx5 command; typically this is:

/usr/ansys_inc/v150/CFX/bin/cfx5.exe

Note

When you start ANSYS CFX Launcher, the displayed **Working Directory** is not the directory the launcher was started in; the directory is defined by the settings stored in CFXPreferences.ccl. To default the working directory to the current directory at start-up, set the CFX_LAUNCH_START_IN_CWD environment variable to 1.
Chapter 5: ANSYS CFX in ANSYS Workbench

ANSYS CFX components can be run in two modes:

- As stand-alone applications started from the ANSYS CFX Launcher and independent of the ANSYS Workbench software. This mode is described in Using the ANSYS CFX Launcher (p. 19).
- As applications launched from ANSYS Workbench.

This chapter describes using ANSYS CFX in ANSYS Workbench:

5.1. The ANSYS Workbench Interface
5.2. An Introduction to Workflow in ANSYS Workbench
5.3. Design Exploration Interface
5.4. Using ANSYS Workbench Journaling and Scripting with ANSYS CFX
5.5. Archiving ANSYS CFX Projects
5.6. Using Remote Solve Manager with ANSYS CFX
5.7. ANSYS CFX Tutorials and ANSYS Workbench
5.8. Tips on Using ANSYS Workbench

Note

This chapter assumes that you are familiar with using ANSYS CFX in stand-alone mode. You should consult the ANSYS Workbench help for more detailed information on ANSYS Workbench.

Tip

For examples of using ANSYS CFX in ANSYS Workbench, see the following tutorials:

- Oscillating Plate with Two-Way Fluid-Structure Interaction in the CFX Tutorials
- Aerodynamic and Structural Performance of a Centrifugal Compressor in the CFX Tutorials

Important

CFX in ANSYS Workbench does not support the use of filenames or project names that contain multiple consecutive spaces, or the "$", "#", or "" characters anywhere in their file path.

5.1. The ANSYS Workbench Interface

To launch ANSYS Workbench on Windows, click the Start menu, then select All Programs > ANSYS 15.0 > Workbench 15.0.
To launch ANSYS Workbench on Linux, open a command line interface, type the path to “runwb2” (for example, “~/ansys_inc/v150/Framework/bin/Linux64/runwb2”), then press **Enter**.

The ANSYS Workbench interface is organized to make it easy to choose a **system** (a group of components) that will enable you to solve particular types of problems. Once you have chosen a system from the **Toolbox** and moved it into the **Project Schematic**, supporting features such as Properties and Messages provide orienting information. These features and the status indicators in the system cells guide you through the completion of the System steps.

The figure that follows shows ANSYS Workbench with a **TurboGrid** component system and a **Fluid Flow (CFX)** analysis system open and linked together. The properties of cell A1 (**TurboGrid**) are displayed in the **Properties** view:

The following sections describe the main ANSYS Workbench features.

### 5.1.1. Toolbox

The **Toolbox** shows the systems available to you:
Analysis Systems
Systems that match the workflow required to solve particular types of problems. For example, the Fluid Flow (CFX) system contains tools for creating the geometry, performing the meshing, setting up the solver, using the solver to derive the solution, and viewing the results.

Component Systems
Software elements upon which Analysis Systems are based. For example, the CFX component system contains Setup (CFX-Pre), Solution (CFX-Solver Manager), and Results (CFD-Post). The Results component system contains only Results (CFD-Post).

Custom Systems
Systems that combine separate analysis systems. For example, the FSI: Fluid Flow (CFX) > Static Structural system combines ANSYS CFX and the Mechanical application to perform a unidirectional (that is, one-way) Fluid Structure Interaction (FSI) analysis.

Design Exploration
Systems that enable you to see parametric change of outputs in relation to changing inputs.

Note
Which systems are shown in the Toolbox depends on the licenses that exist on your system. You can hide systems by enabling View > Toolbox Customization and clearing the check box beside the name of the system you want to hide.

To begin using a system, drag it into the Project Schematic area.

5.1.2. Project Schematic
The Project Schematic enables you to manage the process of solving your CFD problem. It keeps track of your files and shows the actions available as you work on a project. At each step you can select the operations that process or modify the case you are solving.

When you move a system from the Analysis Systems toolbox to the Project Schematic, you will see a set of tools similar to the following:

Each white cell represents a step in solving a problem. Right-click the cell to see what options are available for you to complete a step.
Many cells launch specialized software that enables you to perform the task required by that step. For example, in a Fluid Flow (CFX) system:

- **Geometry > New Geometry** launches DesignModeler.
- **Mesh > Edit** launches the Meshing Application.
- **Setup > Edit** launches CFX-Pre.
- **Solution > Edit** launches CFX-Solver Manager.
- **Results > Edit** launches CFD-Post.

However, the system cells are not simply launching other software, they operate to advance the workflow. For example, if the **Mesh** cell is in the state **Update required**, you will not be able to launch CFX-Pre from the **Setup** cell until the **Mesh** cell has been updated.

### 5.1.3. Workspace Tabs

Systems such as Engineering Data, DesignXplorer, and Parameters, can be placed in the **Project Schematic** and can be opened in arrangements of views, called **workspaces**. Native workspaces are edited directly within Workbench. Each native workspace is shown in its own tab with its Outline, Properties, Table, and Chart views displayed when appropriate. Tabs can be opened by editing a system cell from the **Project Schematic**. You can switch between workspaces by selecting their respective tabs. For more details on tabs and the views available within tabs, see **Tabs within Workbench** in the **Workbench User’s Guide** and **Views within Tabs in the Workbench User’s Guide**.

### 5.1.4. View Bar

You control which views are displayed by opening the **View** menu and setting a check mark beside the view you want to display. If you minimize that view, it appears as a tab in the View Bar and the check box is cleared from the **View** menu.
5.1.5. Properties View

The Properties view is a table whose entries describe the status of a system. These entries vary between system cells and are affected by the status of the cell. Some entries in the Properties area are writable; others are for information only.

To display the Properties for a particular cell, right-click the cell and select Properties. Once the Properties view is open, simply selecting a cell in the Project Schematic will display that cell’s properties.

The following properties are specific to ANSYS CFX components:

<table>
<thead>
<tr>
<th>Setup Cell Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Physics Status</td>
<td>Provides information about the current settings in ANSYS CFX-Pre and describes how to adjust them. This information includes details on any physics validation errors that require attention before the solution can update (which is the same information that is available in the CFX-Pre physics validation summary).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Solution Cell Properties</th>
<th></th>
</tr>
</thead>
</table>
| Initialization Option¹   | **Update from Initial Conditions** causes CFX-Solver Manager to use either an upstream solution cell, the Initial Values definitions on the Define Run dialog box of CFX-Solver Manager, or the initial conditions from the current state of the Setup cell. (To have this take effect, you have to remove any generated information by right-clicking on Clear Generated Data on the Solution cell; that is, the Solution cell cannot be in an up-to-date or interrupted state.)  

**Update from Current Solution Data if possible** causes CFX-Solver to use the previous solution (if this exists) as its initial conditions.  

If there is no previous solution run, CFX-Solver will use either an upstream solution cell, the Initial Values definitions on the Define Run dialog box of CFX-Solver Manager, or the initial conditions from the current state of the Setup cell.

**Note**

- This is the default setting, which is not desirable for the second and subsequent updates of transient cases, for starting from initial conditions provided by another system, or for a situation in which you have divergent results and do not want to start an update from those bad results.

- A Results Error file (.res.err) produced by the CFX Solver during a failed run is treated as current cell data by the Solution cell; however, the Solution cell will not be marked Up-to-Date. These files may not be usable for initializing a subsequent update when the Initialization Option **Update from Current Solution Data if possible** is selected. In these situations, update from the originally defined initial conditions by selecting Clear Generated Data, or by changing the Initialization Option on the Solution cell.
| **Execution Control Conflict Option** | If you add or change Execution Control in CFX-Pre in a way that is perceived to conflict with the Execution Control settings stored in the Solution cell, an error message appears when you attempt to update the Solution cell. From the Properties view you can choose to set Workbench to:

- **Warn** (the default, which enables you to decide on a case-by-case basis by using the Solution cell’s shortcut menu)

- **Use Setup Cell Execution Control**

- **Use Solution Cell Execution Control**

See [Resolving Execution Control Conflicts](p. 27) for details.

| **Load Option** | Choose **Last results only** to load only the last configuration of a multi-configuration results file, or only the last results from a results file that contains a run history, into CFD-Post.

Choose **Complete history as a single case** to load all configurations of a multi-configuration run as a single case, or all of the results history from a results file that contains a run history. In either case, only one set of results will appear in the CFD-Post viewer, but you can use the timestep selector to move between results. This option is not fully supported.

**Note**

When multi-configuration files are loaded as a single sequence, the solution expressions (Reference Pressure, and so on) represent the last configuration, no matter which configuration is currently viewed.

Choose **Complete history as separate cases** to load all configurations from a multi-configuration run into separate cases. If a results file with run history is loaded, CFD-Post loads the results from this file and the results for any results file in its run history as separate cases. Each result appears as a separate entry in the tree.

| **Update Option** | Controls whether the update proceeds **Run in Background**, **Run in Foreground**, or **Submit to Remote Solve Manager**.

- During a foreground update, the user interface strictly limits what you can do. For example, you cannot edit other cells, save, or quit.

- During a background update, the user interface allows other operations and updates on other cells to take place, and you can also save and quit the project.

After saving and quitting, the solver run will still continue. You can reopen the project and use the **Reconnect** button to access data that was put into batch mode.

- If you **Submit to Remote Solve Manager**, you need to specify the **Solve Manager** (use **localhost** for a local parallel run on a machine that has the appropriate parallel processing software installed and configured) and the
Queue (which you define using the Remote Solve Manager software). See Using Remote Solve Manager with ANSYS CFX (p. 43) for details.

**Note**

The run mode for the update to the Solution cell is set on the CFX-Solver Manager's Define Run dialog box. If you specify a remote host, you must ensure that the run mode you choose is supported on that host.

For a project that has been saved, a foreground update that is in progress can be made into a background update by using the Switch Active Solution to Background context menu option. This action will not change the Update Option setting for the next run.

### Results Cell Properties

<table>
<thead>
<tr>
<th>Generate Report</th>
<th>Select this check box to automatically publish a report. The location of the report is displayed in the Files view.</th>
</tr>
</thead>
</table>

---

aThis setting synchronizes interactively with changes in the Initialization Option setting in the ANSYS CFX-Solver Manager's Define Run dialog box.

bFor details, see Configurations in the CFX-Pre User's Guide.

### 5.1.5.1. Resolving Execution Control Conflicts

If you add or change Execution Control in CFX-Pre in a way that is perceived to conflict with the Execution Control settings stored in the Solution cell, an error message appears when you attempt to update the Solution cell.

To resolve the error, right-click the Solution cell and choose one of the following options:

- Using execution control from Setup cell
- Using execution control from Setup cell always
- Using execution control from Solution cell
- Using execution control from Solution cell always

The Using execution control from Setup | Solution cell options enable you to decide how to resolve the conflict on a case-by-case basis. Alternatively, you can choose one of the Using execution control from Setup | Solution cell always options. The latter options change your Workbench Options for CFX. To reset that choice, go to Tools > Options > CFX and change the value of the Set the default execution control conflict option for the Solution cell field to one of:

- Warn (the default, which enables you to decide on a case-by-case basis by using the Solution cell's shortcut menu)
- Use Setup Cell Execution Control
- Use Solution Cell Execution Control
5.1.6. Resolving a 2-Way FSI Error

In some circumstances after you have set up a 2-way FSI case and attempted to start the run, you may see the following error:

The Mechanical Input File specified on the MultiField tab was not found. Please specify a valid Mechanical Input File.

This happens when the solver control has been edited after the execution control is already set. The workaround is to close the Solver Manager, reset the Solution cell, and re-edit the solver control.

5.1.7. Files View

The Files view shows the files that are in the current project. The project files are updated constantly, and any “save” operation from the ANSYS CFX components will save all files associated with the project.

--- Important ---

Although the Files View reveals the data files that make up a project, you should not attempt to manipulate these files directly, as project data management will proceed unaware of your changes and with unpredictable results.

5.1.7.1. ANSYS CFX Files in ANSYS Workbench

ANSYS Workbench associates data with system cells. This data may be stored in different ways, including as part of the ANSYS Workbench project file or as separate files. When files are generated, they appear in the Files view. This view can be used to identify which files are associated with each cell.

The table that follows associates cell types with file types and gives typical extensions for those file types.

<table>
<thead>
<tr>
<th>System Cell</th>
<th>File Type</th>
<th>File Extension Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometry</td>
<td>Geometry File</td>
<td>.agdb</td>
</tr>
<tr>
<td>Mesh</td>
<td>Mesh File</td>
<td>.cmdb (CFX-Mesh)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>.mshdb (Mesh Database File)</td>
</tr>
<tr>
<td>Setup</td>
<td>CFX-Pre Case File</td>
<td>.cfx</td>
</tr>
<tr>
<td></td>
<td>CFX-Solver Input File</td>
<td>.defa, .mdefa</td>
</tr>
<tr>
<td>Solution</td>
<td>CFX-Solver Output File</td>
<td>.outa</td>
</tr>
<tr>
<td></td>
<td>CFX-Solver Results File</td>
<td>.resa, .mresa</td>
</tr>
<tr>
<td></td>
<td></td>
<td>.trn (Transient Results File)a</td>
</tr>
<tr>
<td>Results</td>
<td>CFD-Post State File</td>
<td>.csta</td>
</tr>
<tr>
<td></td>
<td>CFD-Post Output Files</td>
<td>AnsysReportLogo.png a</td>
</tr>
</tbody>
</table>

---
5.1.8. Sidebar Help

In addition to having a visual layout that guides you through completing your project, you can also access Sidebar Help by pressing F1 while the mouse focus is anywhere on ANSYS Workbench. Sidebar Help is a dynamically generated set of links to information appropriate for helping you with questions you have about any of the tools and systems you currently have open.

5.1.9. Shortcuts (Context Menu Options)

You can access commonly used commands by right-clicking in most areas of ANSYS Workbench. These commands are described in Context Menus in the Workbench User's Guide. In addition to those shortcuts, there is a command that is specific to ANSYS CFX:

**Recreate Deleted Cells**

When you import a mesh file into CFX-Pre from a Fluid Flow (CFX) system and no geometry or mesh exists in the upstream cells, the Mesh and Geometry cells are automatically deleted. You can restore these cells by right-clicking the system header and selecting **Recreate Deleted Cells**.

There are also shortcut commands that are specific to CFX **Solution** cells:

**Display Monitors**

Opens the CFX-Solver Manager and shows either the monitors of the run in progress or, if there is no run in progress, the results of the latest solver run associated with the cell.

If you are monitoring the progress of a Remote Solve Manager run, by default the progress reports update every 30 seconds. However, you can adjust this through the **Progress Download Interval**

Note

If running using RSM you cannot use the CFX-Solver Manager to edit, interrupt, or stop the run in progress, or to trigger a manual backup file.

Import Solution

Displays the most recent CFX Solver Results files imported (if any) and enables you to browse for such files using the Open dialog box, where you can specify the CFX Solver Results file to load. When the results file is loaded, the system will display only the Solution cell and the Results cell.

Continue Calculation

Performs an update of the Solution cell, completing a previously stopped run (if one is available), or otherwise restarts the current run.

Clear Execution Control

When you start a solver run or when you click Save Settings on the Define Run dialog box of the CFX-Solver Manager, the settings from the Define Run dialog box are stored for the Solution cell that launched the solver. These are the execution control settings for that cell; the Clear Execution Control command removes those settings.

Note

You should not clear the execution control settings while the CFX-Solver Manager is running as this can make file paths in the Define Run dialog box inaccurate.

Clear Old Solution Data

Enables you to reduce the use of disk space. There are two options:

Data Not Referenced by Current Solution

Removes all the results files except the most recent one and any results files to which it refers.

All Old Data

Removes all the results files except the most recent one.

5.1.10. File Operation Differences

ANSYS CFX applications launched from ANSYS Workbench have default locations for file operations that are appropriate for ANSYS Workbench:

• Save operations default to the user_files directory. The user_files directory appears under the directory that holds the Project file (projectfile_name/user_files/).
If the default directory has already been set, changing the save location in a file dialog box also changes the default save directory. If a change is made to the project directory through ANSYS Workbench, that will also reset the default directory.

**Note**

A change in defaults is held only for the duration of the ANSYS CFX application session (that is, an exit and re-edit of an ANSYS CFX application will reset the defaults back to project user_files for export operations and to the permanent files directory for import operations.

- Open operations default to the permanent files directory. The permanent files directory holds the Project file.
- Export operations initially default to the user_files directory, but change to the last directory used for an export operation during a session.

In addition, there is an icon in the directory tree that takes you to the user_files, and all recent directory selections are available from the directory path drop-down selector.

### 5.2. An Introduction to Workflow in ANSYS Workbench

This section walks through an example of using ANSYS CFX in ANSYS Workbench to perform a fluid-flow analysis. This walkthrough assumes familiarity with the basic ANSYS Workbench and ANSYS CFX applications and does not discuss the details of the steps within each application.

The data flow between cells (and systems) drives the workflow.

1. You begin by launching ANSYS Workbench, which opens as an unsaved project and displays the available Analysis Systems.
2. In your file system you create a directory in which to store your project files. You then select File > Save As and save your new project to that directory. This automatically sets your working directory for this project.

3. In the Analysis Systems toolbox, double-click Fluid Flow (CFX) to create a fluid-analysis system in the Project Schematic. (Notice that if you “hover” over systems in the Toolbox, a tool tip appears.)

The fluid-analysis system in the Project Schematic shows the steps in performing a fluid analysis:

1. Create or import a geometry.
2. Create a mesh for the geometry.
3. Set up the analysis that will be sent to the solver.
4. Control and monitor the solver to achieve a solution.
5. Visualize the results in a post-processor and create a report.

4. In addition to showing those steps in appropriately named cells, each cell can launch a tool that will enable you to perform the task it names. Right-click the Geometry cell to see your options for adding a geometry to your project:
5. As you move through the cells from **Geometry** to **Results**, you can choose to launch the tool that will enable you to complete the cell’s step:

   a. Create a new geometry with the DesignModeler application (Geometry cell).

   b. Create a new mesh with the Meshing application (Mesh cell).

   c. Edit the case with CFX-Pre (Setup cell).

   d. Run the solver by updating the Solution cell, or optionally edit the Solution cell and use the **Define Run** dialog box from CFX-Solver Manager.

---

**Note**

The **Custom Solver Options** (**Custom Executable** and **Solver Arguments**), which are available in the CFX-Solver Manager in stand-alone mode, are not available in CFX-Solver Manager launched from ANSYS Workbench.
e. Display of the results with CFD-Post (Results cell).

**Note**

You could open a Fluid Flow (CFX) system and go immediately to the **Setup** cell to import an existing case. When the case is loaded, the now-unnecessary **Geometry** and **Mesh** cells disappear.

6. When the analysis is complete and the project is finished, you save the project (and therefore the associated files). Once a project has been saved, it can be re-opened at a later date for review or modification of any aspect of the simulation.

**Important**

Saving a project enables you to re-open the project on the machine that originally created it. To make the project available on another machine, you need to use **File > Archive** to create a project archive. To open the project on a different machine, run **File > Restore Archive** on that machine.

### 5.2.1. Using RIF Generation in CFX-Pre in ANSYS Workbench

When using the RIF Flamelet feature in CFX-Pre with Workbench, be aware that RIF Generation in CFX-Pre is an asynchronous activity that will complete in the background. You must ensure that the generation is complete before updating the Solution cell.

While it is possible to journal and play back sessions involving RIF generation, you should take extra care about these issues:

- Playback with Workbench in interactive mode will be frozen by an **Application Error** dialog box stating that RIF generation has begun. Playback will proceed when the dialog box is closed. (In batch mode, Workbench simply logs this message and proceeds immediately.)

- Once Workbench proceeds with playback (in interactive or batch modes), a subsequent Solution update can fail if the flamelet file does not yet exist. The best workaround is to insert a pause into the journal file before the Solution Update command. The pause must be long enough to encompass the RIF generation process; for example, if your RIF generation takes less than 5 minutes, insert a pause of 300 seconds:

  ```python
time.sleep(300)
  ```

### 5.2.2. Data Flow in Systems and Between Systems

The cells in a system communicate status with each other. For example, when you change a mesh in the Mesh cell, the Setup cell will report that its software (CFX-Pre) requires a refresh to re-read the "upstream" data.

Similarly, the same type of data flow occurs between systems. For example, if you have an FSI: Fluid Flow system (as shown in the image below), data and status from the Fluid Flow (CFX) Geometry cell will flow both to the Fluid Flow (CFX) Mesh cell and the Static Structural Geometry cell. Data flow between systems is shown by interconnecting lines:
5.3. Design Exploration Interface

Design Exploration enables you to modify the geometry and physics of your project so that you can determine the influence of selected design parameters defined in your model. You do this by declaring design input parameters in CFX-Pre (see Outline Tree View Shortcut Menu Commands in the CFX-Pre User's Guide) and input parameters and output parameters in CFD-Post (see Expressions Tree View in the CFD-Post User's Guide), then running a Design Exploration study with ANSYS CFX in ANSYS Workbench.

You can apply a DesignXplorer study to a converged project by opening the project in ANSYS Workbench and double-clicking a Design Exploration system from the left pane. This displays the design exploration system under the Parameter Set bar in the Project Schematic.
Note

- A sample tutorial describing how to use design exploration in ANSYS CFX is available; see Optimizing Flow in a Static Mixer.

- For more information on using design exploration in ANSYS Workbench, see Design Exploration User's Guide.

5.4. Using ANSYS Workbench Journaling and Scripting with ANSYS CFX

Journaling is the capturing of ANSYS Workbench actions (creating a project, opening a system, and so on) to a file. For ANSYS CFX applications, CCL and command actions are embedded within ANSYS Workbench actions. Scripting refers to the processes of editing and running a journal file in ANSYS Workbench. With scripting, you could, for example, implement a prescribed workflow.
This section describes how to acquire, edit, and run script files that have commands that affect ANSYS CFX components. For more general information, see Using Journals and Scripts in the Workbench User’s Guide.

**Note**

- Journal actions such as a CFD-Post Export or the loading of a static .res file record the path of the file. You may need to manually adjust this file path before attempting to rerun the journal, particularly if you have created the journal using an unsaved project. More generally, when you create a project, you should save the project immediately to set file paths that ANSYS Workbench uses (rather than require ANSYS Workbench to use file paths that have temporary directories, as happens before the project is saved).

- The handling of file paths described in File Path Handling in ANSYS Workbench in the Workbench Scripting Guide applies to file references that are made outside of CCL and command actions.

- Journal files must not contain an Undo command from a CFX application.

### 5.4.1. Acquiring a Journal File with ANSYS CFX in ANSYS Workbench

The basic workflow for acquiring a journal file with ANSYS CFX in ANSYS Workbench is as follows:

1. Start ANSYS Workbench.
2. Save the project. (This enables ANSYS Workbench to set file paths that will be usable when you play back journal operations that involve the loading or exporting of files.)
4. From **Toolbox** panel, open an ANSYS CFX system (such as **Component System > CFX**).
5. Create and run an ANSYS CFX simulation. The actions you perform are captured by the Journaling process and written to the .wbjn file that you named in step 2.
6. Stop journaling: **File > Scripting > Stop Recording Journal**.
7. Optionally, edit the journal file (this is the process of *scripting*).

#### 5.4.1.1. Journal of an Operation That Uses CFX-Pre

When you record a journal file of an operation that uses CFX-Pre, the contents will be similar to the following code snippets. In these snippets, a user has opened ANSYS Workbench and recorded a session that created a CFX system, opened CFX-Pre, imported a mesh file (**SYS-1.cmdb**), created an inlet boundary, created an outlet boundary, and saved the project as **saveJou.wbpj**:

**Create the CFX system**

```plaintext
template1 = GetTemplate(TemplateName="CFX")
system1 = template1.CreateSystem(Position="Default")
```
Edit the Setup cell and import a mesh (SYS-1.cmdb)

```python
setup1 = system1.GetContainer(ComponentName="Setup")
setup1>Edit()
setup1.SendCommand(Command="gtmImport filename=C:\SYS-1.cmdb, 
    type=GTM_DSDB, genOpt= -names 'CFXMesh ACMO_Simulation' 
    -contact read -relative 0.001, units=m, nameStrategy= Assembly")
```

**Note**

The `setup1.SendCommand` command above must be entered as a single line; multiple lines are shown here for readability.

Create an inlet boundary (in1)

```markdown
setup1.SendCommand(Command="**FLOW: Flow Analysis 1**
    **DOMAIN: Default Domain**
    \&replace **BOUNDARY: in1**
    Boundary Type = INLET
    Interface Boundary = Off
    Location = F18.12
    **BOUNDARY CONDITIONS:**
    **FLOW REGIME:**
    Option = Subsonic
    **END # FLOW REGIME:**
    **MASS AND MOMENTUM:**
    Normal Speed = 1 [m s^-1]
    Option = Normal Speed
    **END # MASS AND MOMENTUM:**
    **TURBULENCE:**
    Option = Medium Intensity and Eddy Viscosity Ratio
    **END # TURBULENCE:**
    **END # BOUNDARY CONDITIONS:**
    **END # BOUNDARY:in1**
    **END # DOMAIN:Default Domain**
    **END # FLOW:Flow Analysis 1***)
```

Create an outlet boundary (out)

```markdown
setup1.SendCommand(Command="**FLOW: Flow Analysis 1**
    **DOMAIN: Default Domain**
    \&replace **BOUNDARY: out**
    Boundary Type = OUTLET
    Interface Boundary = Off
    Location = F17.12
    **BOUNDARY CONDITIONS:**
    **FLOW REGIME:**
    Option = Subsonic
    **END # FLOW REGIME:**
    **MASS AND MOMENTUM:**
    Option = Average Static Pressure
    Pressure Profile Blend = 0.05
    Relative Pressure = 0 [Pa]
    **END # MASS AND MOMENTUM:**
    **PRESSURE AVERAGING:**
    Option = Average Over Whole Outlet
    **END # PRESSURE AVERAGING:**
    **END # BOUNDARY CONDITIONS:**
    **END # BOUNDARY:out**
    **END # DOMAIN:Default Domain**
    **END # FLOW:Flow Analysis 1***)
```

Quit CFX-Pre

```python
setup1.Exit()
```
Save the Project file

```python
Save(
    FilePath="C:\saveJou.wbpj",
    Overwrite=True)
```

In the above snippets, note how CCL and command actions for CFX-Pre are encapsulated as arguments of SendCommand instructions.

### 5.4.1.2. Journal of an Operation That Uses CFX-Solver Manager

When you record a journal file that refreshes and updates a CFX Solution cell, the contents will be similar to the following snippet.

```python
RefreshComponent(Component="/Schematic/Cell:Solution")
UpdateComponent(
    Component="/Schematic/Cell:Solution",
    AllDependencies=True,
    Force=False)
```

### 5.4.1.3. Journal of an Operation That Creates a Plane in CFD-Post

In the following incomplete snippet, a user has created a Results system, edited the Results cell, loaded a CFX-Solver Results file (`StaticMixer_001.res`) and then created a plane named "Plane 1":

#### Create the Results system

```python
template1 = GetTemplate(TemplateName="Results")
system1 = template1.CreateSystem(Position="Default")
```

#### Edit the Results cell and load the Results file (`StaticMixer_001.res`)

```python
results1 = system1.GetContainer(ComponentName="Results")
results1.Edit()
results1.SendCommand(Command="""
                           DATA READER:
                           Append Results = true
                           Clear All Objects = false
                           Edit Case Names = false
                           Multi Configuration File Load Option = Separate Cases
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
                           Clear All Objects = false
                           Append Results = true
                           Edit Case Names = false
                           Open in New View = true
                           Keep Camera Position = true
                           Load Particle Tracks = true
                           Files to Compare =
                           Open to Compare = false
                           Multi Configuration File Load Option = Separate Cases
```
**5.4.2. Editing a Journal File (Scripting)**

*Scripting* refers to the processes of editing and running a journal file in ANSYS Workbench. You can create your own scripts and include the power of Python to implement high-level programming constructs for input, output, variables, and logic. The two examples that follow illustrate this for CFX-Pre and CFD-Post.

### 5.4.2.1. Example: Using a Script to Change the Turbulence Setting in a Setup Cell

If you have an ANSYS Workbench project currently open, you can run a script to change the characteristics of the simulation. For example, if you have edited a Setup cell from an ANSYS Workbench system, loaded a case with a Default Domain in Flow Analysis 1, and want to use an interactive script to set CFX-Pre to use one of two turbulence settings, you can run a script similar to the one that follows.

Before running this script, you would have to first open the **Command Window** dialog box (by selecting **File > Scripting > Open Command Window** from the ANSYS Workbench main menu). To run the script, you would select **File > Scripting > Run Script File** from the ANSYS Workbench main menu and then use the browser to open the file containing the script.

```python
x = int(input("Enter: 1=k epsilon, 2=Shear Stress Transport (SST): "))

if x == 1:
    print 'k epsilon'
    SetScriptVersion(Version="12.1")
    system1 = GetSystem(Name="CFX")
    setup1 = system1.GetContainer(ComponentName="Setup")
    setup1.Edit()
    setup1.SendCommand(Command="FLOW: Flow Analysis 1
    DOMAIN: Default Domain
    FLUID MODELS:
    TURBULENCE MODEL:
    Option = k epsilon
    END # TURBULENCE MODEL:
    TURBULENT WALL FUNCTIONS:
    Option = Scalable
    END # TURBULENT WALL FUNCTIONS:
    END # FLUID MODELS:
    END # DOMAIN:Default Domain
    
END

results1.SendCommand(Command="## Sending visibility action from View...
>show /PLANE:Plane 1, view=/VIEW:View 1"

Save the project

```Save

```python
Save(
   FilePath=r"C:\SaveJou.wbpj",
   Overwrite=True)

The commands in the script above are the default values for a plane.

Release 15.0 - © SAS IP Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.

ANSYS CFX in ANSYS Workbench
elif x == 2:
    print 'Shear Stress Transport (SST)'
    SetScriptVersion(Version="12.1")
    system1 = GetSystem(Name="CFX")
    setup1 = system1.GetContainer(ComponentName="Setup")
    setup1.Edit()
    setup1.SendCommand(Command='''FLOW: Flow Analysis 1
    DOMAIN: Default Domain
    FLUID MODELS:
    TURBULENCE MODEL:
    Option = SST
    END # TURBULENCE MODEL:
    TURBULENT WALL FUNCTIONS:
    Option = Automatic
    END # TURBULENT WALL FUNCTIONS:
    END # FLUID MODELS:
    END # DOMAIN: Default Domain
    END # FLOW: Flow Analysis 1''')

print 'Done'

Depending on the value of x you input in the Command Window, the script includes the CCL in the appropriate setup1.SendCommand argument to set the TURBULENCE MODEL and TURBULENT WALL FUNCTIONS options in the FLOW: Flow Analysis 1 > DOMAIN: Default Domain > FLUID MODELS object for either the k-Epsilon or the Shear Stress Transport turbulence models.

5.4.2.2. Example: Using a Script to Change an Existing Locator in a Results Cell

If you have an ANSYS Workbench project currently open, you can run a script to change how the results of the simulation are post-processed. For example, if you have edited a Results cell from an ANSYS Workbench system and CFD-Post is displaying a plane named Plane 1, you can run the following script to change the plane to be colored by the variable Velocity or Pressure:

    x = int(raw_input("Enter an integer: 1=Velocity, 2=Pressure: "))

    if x == 1:
        print 'Velocity'
        results1.SendCommand(Command='''PLANE:Plane 1
        Colour Mode = Variable
        Colour Variable = 'Velocity'
        END''')

    elif x == 2:
        print 'Pressure'
        results1.SendCommand(Command='''PLANE:Plane 1
        Colour Mode = Variable
        Colour Variable = Pressure
        END''')

Depending on the value of x you input, the script includes the CCL in the appropriate results1.SendCommand argument to set the values for Colour Mode and Colour Variable in the PLANE:Plane 1 object for either the Velocity or Pressure variable.

5.4.3. Limitations to Scripting Actions with ANSYS CFX Applications

There are the following limitations to scripting ANSYS CFX applications. When interfacing with the Solution cell:

- On the Define Run dialog box, the Reload run settings from file icon is not scriptable.
5.5. Archiving ANSYS CFX Projects

Archiving is the process of making a project available to another machine; you use File > Archive to create a project archive. After you set the file name for the project and click Save, the Archive Options dialog box appears, enabling you to set which optional files to include in the archive.

**Note**

You should not archive or restore a project while the CFX-Solver Manager is running.

Archiving ANSYS CFX projects follows the steps above, but the resulting archive is created with the restrictions listed below.

The following **will** be archived (provided that you choose the appropriate options when archiving):

- Flamelet/RIF libraries
- Profile boundary files
- Initial values files provided by the Workbench project schematic and those manually selected by you from within CFX-Pre
- PAR files specified in CFX-Pre
- ANSYS Input File (provided by the Workbench project schematic or manually specified by you from within CFX-Pre)
- RGP files
- If you choose to archive with the Result/Solution files option selected, CFX-Solver Results files are included.
- If you choose to archive with the Imported files external to project directory option selected, imported files are included. For example, an imported geometry file will be added to the import_files directory in the archived version of the project.
- In the normal workflow, no files are written to the User_files directory. However, if you perform operations such as the export of a file from CFD-Post, that file will be copied to User_files. If you then choose to archive with the Items in the User_files folder option selected, such files are included in the archive.

The following **will not** be archived:

- Directory structures
5.6. Using Remote Solve Manager with ANSYS CFX

Remote Solve Manager (RSM) enables you to configure queues containing compute servers (machines that will run partitions of a job). A serial run is one in which there is one partition, a local parallel run is one in which all of the partitions are executed on the same compute servers (not necessarily your local machine), and a distributed parallel run is one in which partitions are distributed and run across multiple hosts. When runs on remote hosts are completed, the resulting files are automatically sent back to your local machine.

CFX Distributed Parallel is supported via RSM for batch queuing systems.

Remote Solve Manager generally enables you to solve on remote machines as many types of runs as can be solved on your local machine, but with various restrictions that are generally related to the availability of external files (files that you have manually specified for certain features in CFX applications) on the remote machine. For remote runs, where external files may not be available using the same path as the machine on which the run was set up, RSM has to identify the location of any external files and then copy them to the remote location. Not all external files can be treated correctly at the current release. The restrictions include:

- Solver models that include user-defined remeshing may not be reliably run in RSM mode if the External Command refers to a command that is not available in the same location as that specified in the External Command parameter.

- The following are unsupported:
  - Directory structures (unsupported, but may work)
  - Custom Solvers
  - User-defined remeshing
  - TASCFlow Real Gas Properties
  - Manual specification of Initial Values files (not set up through the Workbench project schematic)
  - Files referenced from within another non-CFX file (for example, a file referenced by an ANSYS Input File)
  - User FORTRAN source code or libraries (unsupported, but may work)
  - Any file manually specified in CFX-Solver Manager

Some unsupported features may work if the file paths for external files on the remote machine are the same as on the machine that set up the case.

To learn how to configure Remote Solve Manager, see RSM Overview in the Remote Solve Manager User’s Guide.
5.6.1. Configuring CFX over Remote Solve Manager

To configure a local parallel run for a CFX/Fluid Flow (CFX) case using a previously configured Remote Solve Manager in either serial mode or with previously installed parallel processing software (such as Platform MPI):

1. Start Workbench.
2. Drag either a CFX or a Fluid Flow (CFX) system into the Project Schematic.
3. Load the case into the Setup cell.
4. Select View > Properties on the Solution cell to set the following Solution Process options:
   a. Set Update Option to Submit to Remote Solve Manager.
   b. Set Solve Manager from the drop-down menu. (The available hosts are determined by the queue.)
   c. Set Queue to a queue listed in the drop-down menu. (Use Remote Solve Manager to add queues and Compute Servers.)
   d. Set the Solution Process as desired. Note that:
      • Serial runs are always supported.
      • Platform MPI Local Parallel is supported on all platforms that support RSM, and therefore is the safest choice.
      • Distributed parallel processing is supported only when the RSM Client is also the RSM Manager and acts as one of the Compute Servers (remote machines can also act as Compute Servers in this configuration).
5. Update the Solution cell. A dialog box appears that gives the status of the update.

5.6.2. Limitations When Using Remote Solve Manager with ANSYS CFX

ANSYS CFX has the following limitations when used with Remote Solve Manager:

• You cannot edit, interrupt, or stop a run that is in progress using the CFX-Solver Manager. You can, however, interrupt the run using the Workbench progress bar.
• You cannot create a manual backup file using the Backup button in the CFX-Solver Manager.

• By default the CFX-Solver Manager will update its monitors only every 30 seconds, rather than continuously. However, you can adjust this through the Progress Download Interval setting in the Solution cell Properties. See Submitting Solutions for Local, Background, and Remote Solve Manager (RSM) Processes in the Workbench User’s Guide for details.

5.7. ANSYS CFX Tutorials and ANSYS Workbench

The ANSYS CFX tutorials are generally written for ANSYS CFX in stand-alone mode, but some also include information on running the tutorial in ANSYS Workbench. For general information on doing this, see Running ANSYS CFX Tutorials Using ANSYS Workbench in the CFX Tutorials.

The tutorial Optimizing Flow in a Static Mixer in the CFX Tutorials is written specifically for ANSYS Workbench.

Note

When compiling a Fortran file with the cfx5mkext command in CFX-Pre in ANSYS Workbench, a corresponding subdirectory is created for the output under the directory specified by the Default Folder for Permanent File field (which is defined in the ANSYS Workbench > Tools > Options > Project Management pane). When performing this operation in CFX-Pre in stand-alone mode, the subdirectory is created under your working directory.

In CFX-Pre in ANSYS Workbench, when creating the user routine that calls the compiled Fortran subroutine, on the CFX-Pre Basic Settings tab set the Library Path to the directory named in the Default Folder for Permanent Files field (not to the working directory, as you would when running CFX-Pre in stand-alone mode).

5.8. Tips on Using ANSYS Workbench

This section highlights helpful tips on using ANSYS Workbench.

5.8.1. General Tips

5.8.2. Tips for CFX/Fluid Flow Systems

5.8.3. Tips for Parameters and Design Exploration

5.8.1. General Tips

The following are useful tips for the general use of ANSYS CFX in ANSYS Workbench:

5.8.1.1. ANSYS Workbench Interface

A lot of important functionality is available in the shortcut menu (cells, parameter bar, and so on). Also, you should enable the View > Properties view and investigate options for each cell.

Compact Mode is very useful. It turns the schematic into a small non-intrusive button that is always on top, effectively replacing the need for the toolbar navigation.

5.8.1.2. Setting Units

ANSYS Workbench units and options are not passed to ANSYS CFX applications; this could require you to set units twice.
5.8.1.3. Files View

Use the Files view to determine which files were created for each cell/system. This can be very useful if you need to do some runs or change some settings outside of ANSYS Workbench, or if you want to manually delete some but not all files associated with a particular cell. It is easiest to find files associated with a specific cell by sorting the view by Cell ID. This will sort the list by system and then by cell.

5.8.1.4. ANSYS Workbench Preferences: Named Selections

The default setting in Workbench for Named Selection is off, and a filter prefix is specified, in the Tools > Options > Geometry Import settings. In order to make sure that Named Selections specified in DesignModeler propagate through to the meshing stage, you need to enable Named Selections and clear the Filtering Prefixes.

Note

If you select a language other than English under Regional and Language Options in ANSYS Workbench, use of Symmetry and Enclosure operations in DesignModeler can lead to special characters (e.g. Umlauts in German, which are not supported for use in ANSYS CFX) being included in automatically generated Named Selections. You can prevent such Named Selections from being created by either:

- Using Meshing as part of a Fluid Flow (CFX) system (rather than a separate Mesh component system)
- Changing the Advanced Geometry Option > Enclosure and Symmetry Processing, under the Geometry cell properties, from the default Yes/On to No/Off.

5.8.1.5. Mesh Modifications in CFX-Pre in ANSYS Workbench

If you perform any mesh modifications (such as transformations, renaming, glue/unglue, delete) within CFX-Pre on meshes provided by the project schematic, avoid any further changes to the Mesh and Geometry cells providing these meshes.

During a refresh of upstream mesh data, CFX-Pre will require that the same series of mesh modifications and transformations on the new mesh be successfully reapplied. If any of these transformations fail (possibly due to topological changes, or changes to regions and named selections that the transformations operate on), CFX-Pre will issue an error message, and revert to the previous mesh data. Workbench will report the error as an "Application Error" during the mesh refresh, however the project schematic state for the Setup cell will indicate that the refresh was done successfully by being marked as Up-to-date.

To correct this mesh refresh error, the geometry or mesh changes that caused the error should be reverted, or (if possible) the Mesh cell should be disconnected and the Setup cell refreshed again before reconnecting the Mesh cell.

5.8.1.6. Loading .cmdb Files

To import a .cmdb file, you have to use the File > Import option on the main ANSYS Workbench toolbar. This will import the geometry and mesh settings and create a .mshdb file.
It is not possible to read a mesh file without any reference to a geometry file, even when you select **File > Import** and select a `.cmdb` file. A Mesh system that includes a Geometry cell appears (the Geometry cell has a green tick and a red circle with "!"). If you try to link or duplicate such a system, problems are observed.

It is also not possible to read a mesh file without any reference to a geometry file when creating a mesh component system first – you cannot right-click the Mesh cell and select a command to import a `.cmdb` file; only `.gtm` and `.cfx` files are possible choices.

### 5.8.1.7. ANSYS Workbench Connections

When selecting a system in the toolbox, ANSYS Workbench will highlight the cells in any systems already in the Project Schematic to which a valid connection can be made.

Connections between systems in ANSYS Workbench are direction-dependent. This has implications in one-way and two-way FSI cases. For example, in a one-way case you need to transfer the data from the CFX system to the Static Structural system. As a consequence, the CFX system will be positioned to the left of the Static Structural system on the schematic. For two-way FSI, the Static Structural system will be positioned to the left of the CFX system on the schematic.

Connections are not supported from the Setup cells of Steady-State and Transient Thermal analyses systems to the Setup cell of the Fluid Flow systems (for example, thermal two-way FSI).

Using multi-configuration CFX cases as part of a one-way FSI calculation is not supported. The project schematic will permit the connection, but the calculation will fail.

### 5.8.2. Tips for CFX/Fluid Flow Systems

The following are useful tips for the use of CFX/Fluid Flow systems in ANSYS Workbench:

#### 5.8.2.1. Changes in Behavior

The ability to play session files is missing in ANSYS Workbench for ANSYS CFX applications.

The undo stack is cleared in CFX-Pre/CFD-Post after the application receives commands from ANSYS Workbench.

You cannot launch ANSYS CFX products from one another in ANSYS Workbench; you must use the system cells.

ANSYS Workbench "remembers" previous locations of imported files / projects. ANSYS CFX, however, displays different behavior for loading or saving any files, always using the directory specified in the **Tools > Options > Default Folder for Permanent Files** in ANSYS Workbench.

Duplicate node removal for importing Fluent meshes into CFX-Pre is always ON in ANSYS Workbench, regardless of any settings in the ANSYS CFX preferences file. CFX-Pre does not read this file when run in ANSYS Workbench.

#### 5.8.2.2. Duplicating Systems

If you have a Fluid Flow (CFX) system, and you want to duplicate the system in such a way that the duplicate shares Geometry and Mesh with the original system, then right-click the Setup cell of the original Fluid Flow system (not the system header) and choose **Duplicate**. The CFX data associated with the original Setup cell is copied to the duplicated Setup cell, ready for you to modify it.
If you create a setup by duplicating an existing one, the run files associated with the first schematic are named according to the name of the schematic; in this release it is not possible to control the name of the run files in the duplicate schematics.

Duplication normally involves only user files (files for which you have specified settings). For ANSYS CFX, these are the .cfx and .cst files. Other files, which are considered to be "generated" (for instance, the .def, .res, and .out files), are not duplicated.

### 5.8.2.3. Renaming Systems

Rename all your CFX and Fluid Flow (CFX) systems to something unique and meaningful that reflects the contents of the system, especially if there are multiple systems. The names of the files associated with the system cells will incorporate this system name when the files are first created, making it easier for you to identify the files in the Files view. Furthermore, CFD-Post will take the system name (by default "Fluid Flow" for a Fluid Flow system) as the case name of the results in CFD-Post. Note that it is best to rename the systems as soon as they are placed on the Project Schematic, as the generated file names and/or the CFD-Post case names will not necessarily be updated if a system is renamed after the appropriate cells already have associated data (for example, a .cfx file with the Setup cell). It may be useful to reset the Results cell to update the CFD-Post case name if the system is renamed, but you will lose any existing CFD-Post settings and objects by doing this.

### 5.8.2.4. Updating Cells

When you connect an up-to-date Mesh cell to the Setup cell of a CFX or a Fluid Flow (CFX) system, the Mesh cell becomes out-of-date because the relevant data must be created. You must update the Mesh cell.

If a second identical component system is added (CFX+CFX or Fluent+Fluent), there is no need to update the project again. An update of the project is required if a different system component is added (CFX+Fluent or Fluent+CFX).

### 5.8.2.5. Setup Cell

Changing the Mesh Import options (for example, relating to Names Selections or Contact settings) for importing a mesh from a Mesh cell into a Setup cell (CFX-Pre) is not straightforward. The Setup cell will use whatever options are stored in your preferences file at the time when the mesh is imported. You can change these settings by using Tools > Options or by using the Mesh Import form in stand-alone CFX-Pre (choosing Use settings next time). The next time you refresh the Setup cell with a new Mesh, CFX-Pre will use the new mesh import settings. In some circumstances this could lead to unexpected results, for example if you were relying on a specific set of Named Selection options to identify your regions but changed these settings when working on another project.

If you make changes to the execution control in CFX-Pre while you have CFX-Solver Manager open, you need to click the Refresh button on the Define Run dialog box in order to make sure that the CFX-Solver Manager re-reads the new information from the CFX-Solver Input file.

---

**Note**

ANSYS Workbench supports only one connection from Static Structural or Transient Structural systems’ Setup cells to a single CFX or Fluid Flow (CFX) Setup cell for two-way FSI.
5.8.2.6. Solution Cell

When you edit the Solution cell, the Define Run dialog box of the CFX-Solver Manager has a Save Settings button. Clicking this button associates the settings on the dialog box with the Solution cell and closes the dialog box. You must now update the Solution cell to run the CFX-Solver.

Always check that the setting of the Initialization Option is correct for each Solution cell in any CFX-related system. This can be viewed and set using the Properties view on the Solution cell, or can be set on the Define Run dialog box of the CFX-Solver Manager. The default Initialization Option is set to Update from Current Solution Data.

- If you perform a solver run and then want to re-run it using the first solver run to provide initialization, then you can leave the Initialization Option set to Update from Current Solution Data.

- If you perform a solver run and then want to re-run it using the original initialization (provided from another Solution cell, or provided from a specified Initial Values file, or specified in CFX-Pre), then you must either select Clear Generated Data on the Solution cell before making the re-run, or set the Initialization Option to Update from Initial Conditions. Otherwise, the run will continue from the previous results, and a transient run will continue from the last timestep of the previous run, rather than from the beginning.

- If you perform a solver run and want to re-run it using a specified initialization file, you have to Clear Generated Data on the Solution cell, edit the Solution cell to change the Initialization Option in the CFX-Solver Manager to Initial Conditions, set the name of the Initial Values file, and then either Start Run, or Save Settings and Update the cell to perform a new run (otherwise, the run will continue from the previous results).

After running the CFX solver multiple times within the same system, for example when updating the solution or continuing the calculation, you may accumulate unwanted results files from the previous runs. Consider using Reset or Clear Generated Data on the Solution cell before re-running the CFX-Solver on this cell. This deletes all the files from any previous run on that cell (for example, all CFX-Solver Results and CFX-Solver Output files), and prevents the project from getting too large. If you do not want to clear all the files, but want to clear some of them, then open the Files view (ANSYS Workbench View > Files) and sort the list by Cell ID (which is actually the cell coordinates, not the ID). Scroll down to the results file(s) for the desired Solution cell ID. Because you cannot directly delete the files from the view, right-click a result file and select Open Containing Folder. This opens your operating system's file browser at the directory containing the result file, where you can then remove the unwanted files. After doing this, you may want to remove the obsolete file references from the list in the Files view. Multi-select all the red files (sort by ascending size to get them all together) and choose to Remove <file> from List to get ANSYS Workbench to remove them from the Files view completely.

If you set the CFX-Solver to Background mode and shut down ANSYS Workbench, upon restarting ANSYS Workbench and reopening the project, if the solver run has not completed, you will need to use the Reconnect button to continue monitoring the solver run.

The information at end of a CFX-Solver Output file shows only the temporary location for the CFX-Solver Results file, not the final location. The correct locations can be found in the Files view.

CFX-Solver Results files (in particular the .res files) are associated with the Solution cell, not the Results cell. This means that a CFX-Solver Results file cannot be imported onto a Results cell; it can be imported onto a Solution cell of a Fluid Flow or CFX system. Similarly, resetting the Results cell will not remove the CFX-Solver Results file.
ANSYS Workbench permits you to import data from a Polyflow Solution cell into the Solution cell of a CFX system; however, the CFX-Solver execution will fail when the Solution cell of the CFX system is updated.

For simulations involving multiple configurations, initializing a Solution cell of either a Fluid Flow (CFX) analysis system or a CFX component system from another Solution cell is not supported in this release. Attempts to update the downstream Solution cell will result in an error. You must define initialization conditions for each configuration manually.

**5.8.2.7. Results Cell**

In ANSYS Workbench, the state of CFD-Post is associated with the Results cell. To maintain multiple states, you must generate multiple Results systems. For your convenience, you can provide a unique name for each system.

To perform a file comparison in CFD-Post, drag a Solution cell from another system to the Results cell.

You can have CFD-Post generate report output at every update (by setting Generate Reports in Results cell Properties view). The .html file is visible in the Files view: right-click it, select Open containing folder, and double-click the file in the explorer to see the report in a browser.

When updating existing Results cell data (with CFD-Post open) where a turbo chart with an averaged variable was used (for example, turbo reports), a warning dialog box may appear reporting that "No data exists for variable ..." This warning can be ignored.

You can change the CFD-Post multi-configuration load options (available on the Load Results panel of CFD-Post when in stand-alone mode) by editing the Properties of the Solution cell. This is a property of the Solution cell, rather than the Results cell.

**5.8.2.8. Recovering After Deleting Files**

If you accidentally delete the current .def, .res or .out files for a CFX system and the Solution cell status is up-to-date, you may get errors when trying to display the solution monitor or edit the Results cell. In this case you will need to replace the files in the File Manager, or Reset the Solution cell, and update the system. If the .def file is missing, you may also need to Clear Generated Data for the Setup cell before updating the system.

**5.8.2.9. Backwards Compatibility When ANSYS CFX Files Exist in the Original Project**

When importing a .wbdb file (that contains .agdb, .cmdb, .cfx, and .res files), only a Mesh system is imported instead of a "Fluid Flow (CFX)" analysis system. You need to drag a CFX system and associate the files with this system.

Pointers to the original CFX files are present in the Files view. Using the right-click option Import Onto Schematic, a copy of the file is taken and an associated system is generated with the copy - however the Files view now seems to have two versions of the same file.

You can drag a CFX system and associate the files with this system, manually importing the file into the correct cell.

ANSYS Workbench does not support directly importing legacy FSI cases, so you have to create a CFX system from the legacy CFX-Solver Results file, manually link it to the Static Structural system, suppress the old load in Static Structural, and update it to import the load in the proper format from the CFX system.
Files that are moved or deleted and that were previously associated with a cell in the project schematic will be highlighted in red in the Files view. There are right-click options to Remove or Repair the files. You should be aware that ANSYS Workbench will ensure that the file is repaired using a file of a similar type but not necessarily the same name (or contents). If the contents of the repaired file do not match those of the original file, unexpected results may be produced or the case will fail.

5.8.2.10. License Sharing

If you are using license sharing in ANSYS Workbench, you can use only one license for CFX-Pre/CFD-Post even if you have more available. This has implications if, for example, you want to run a long animation in CFD-Post and use CFX-Pre at the same time. If you know you are going to be working with CFX-Pre and CFD-Post at the same time, you need to change the license-sharing setting before starting your project.

5.8.3. Tips for Parameters and Design Exploration

The following are useful tips for the use of parameters and design exploration:

5.8.3.1. Saving Files/Exported Design Points

When using Design Points with ANSYS CFX, check the Exported box next to the Design Point in the Table of Design Points if you want to save and review the solver files. This will export the Design Point as a project that can be loaded and reviewed later. Beware that subsequent changes to the Design Point values for an exported Design Point will also overwrite the exported project save. If you want to keep the original, make a copy of the exported project.

5.8.3.2. Number of Design Points

During a parametric study, the original set of files used to set a problem up is copied for each Design Point, using file space. To minimize the use of file space, minimize the number of unnecessary Design Points.

When working with exported Design Points, you should limit the project schematic only to systems that are involved in the Design Point changes. Having other systems (for example, a CFX system) in the project that are not involved in the Design Point update will mean duplication of these systems' database/results files for every exported Design Point, and this can use a significant amount of disk space.

If you generate a large number of Design Points in a Design of Experiments (DOE), it is possible that a small proportion of them will fail to update, preventing the DOE cell from becoming up-to-date. In such a case, you cannot continue with the rest of this design exploration analysis. The DOE can be modified to remove these failing Design Points by selecting Design of Experiments > Type > Custom and then manually deleting the Design Points that failed to update successfully. Provided that sufficient Design Points remain for adequate analysis, then the DOE can be updated and you can continue with the analysis.

5.8.3.3. Obtaining Solutions for Design Points

When running Design Points with a CFX system with a specified solver maximum residual criterion, you should always set the minimum solution iterations to at least 3 in the Solver Control panel. If this setting is left at the default "1", the solver may stop after one or two iterations, falsely believing convergence has been reached.

Note that you can export Design Points only after you have saved the project.
If you have selected the solution to **Update from Current Solution Data** (default setting), you may need to choose the input parameter values wisely for the **Current Design Point** because it will be the starting solution for all other Design Points. To avoid this situation, set **Update from Initial Conditions** as an **Initialization Option** in the CFX-Solver Manager before updating the Design Points.

### 5.8.3.4. The CFX-Solver Background Mode

In a Design Points study, if you have set the CFX-Solver to **Background mode**\(^2\), none of the Design Points will become up-to-date until all the solver jobs have finished. This is not the case when the CFX-Solver has been set to Foreground mode (the default setting), where each Design Point becomes up-to-date before the next one commences updating. The former option, though, can prove more efficient in terms of speed, especially in the case of long runs on multi-core configurations.

**Note**

When the Licensing Interconnect sharing mode is used, the Update of Design Points in background mode will not work.

### 5.8.3.5. Known Limitations of ANSYS CFX Running in ANSYS Workbench

Although the names of design parameters can be modified using the Parameter Manager within ANSYS Workbench, this is not recommended, because the new names will not be reflected within the CFX application user interfaces.

---

\(^2\)Note that an adequate number of licenses are required for this.
Chapter 6: Help On Help

This chapter discusses:

6.1. Document Conventions
6.2. Accessing Help
6.3. Using the Search Feature

For information on the ANSYS Help Viewer, see:

• Using Help

6.1. Document Conventions

This section describes the conventions used in this document to distinguish between text, file names, system messages, and input that you need to type.

6.1.1. Spelling Conventions

ANSYS CFX documentation uses American spelling:

• atomize/atomization rather than atomise/atomisation
• color rather than colour
• customize/customization rather than customise/customisation
• discretize/discretization rather than discretise/discretisation
• initialize/initialization rather than initialise/initialisation
• linearize/linearization rather than linearise/linearisation
• meter rather than metre
• normalize/normalization rather than normalise/normalisation
• oxidize/oxidizer/oxidation rather than oxidise/oxidiser/oxidisation
• vapor/vaporize/vaporization rather than vapour/vaporise/vaporisation

When searching, use American spellings:

<table>
<thead>
<tr>
<th>For:</th>
<th>Search for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colour Map</td>
<td>Color Map (or try Color Map Command in the CFD-Post User's Guide)</td>
</tr>
<tr>
<td>Colour Mode</td>
<td>Color Mode (or try Color Mode in the CFD-Post User's Guide)</td>
</tr>
<tr>
<td>Colour Scale</td>
<td>Color Scale (or try Color Scale in the CFD-Post User's Guide)</td>
</tr>
<tr>
<td>Colour Tab</td>
<td>Color Tab (or try Color Tab in the CFD-Post User's Guide)</td>
</tr>
<tr>
<td>For:</td>
<td>Search for:</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customisation</td>
<td>Customization (or try Customization in the CFX-Pre User’s Guide)</td>
</tr>
<tr>
<td>Domain Initialisation</td>
<td>Domain Initialization (or try Domain: Initialization Tab in the CFX-Pre User’s Guide)</td>
</tr>
<tr>
<td>Global Initialisation</td>
<td>Global Initialization (or try Initialization in the CFX-Pre User’s Guide)</td>
</tr>
<tr>
<td>Initialisation Tab</td>
<td>Initialization Tab (or try Initialization Tab in the CFX-Pre User’s Guide)</td>
</tr>
<tr>
<td>Linearisation</td>
<td>Linearization</td>
</tr>
<tr>
<td>Turbo Initialisation</td>
<td>Turbo Initialization (or try Turbo Initialization in the CFD-Post User’s Guide)</td>
</tr>
<tr>
<td>Auto-initialise</td>
<td>Auto-initialize (or try Requirements for Initialization in the CFD-Post User’s Guide)</td>
</tr>
<tr>
<td>Uninitialise</td>
<td>Uninitialize (or try Uninitializing Components in the CFD-Post User’s Guide)</td>
</tr>
<tr>
<td>Initialise All Components</td>
<td>Initialize All Components (or try Initialize All Components in the CFD-Post User’s Guide)</td>
</tr>
<tr>
<td>Oxidise/Oxidiser</td>
<td>Oxidize/Oxidiser</td>
</tr>
<tr>
<td>Undefined Colour</td>
<td>Undefined Color (or try Undefined Color in the CFD-Post User’s Guide)</td>
</tr>
<tr>
<td>Synchronise Camera</td>
<td>Synchronize Camera (or try Case Comparison in the CFD-Post User’s Guide)</td>
</tr>
</tbody>
</table>

### 6.1.2. File and Directory Names

Note that on UNIX, directory names are separated by forward slashes (/) but on Windows, usually back slashes are used (\). For example, a directory name on UNIX might be `/CFX/bin` whereas on a Windows system, the same directory would be named `\CFX\bin`.

**Important**

Files names with multiple consecutive spaces cannot be read by ANSYS CFX.

### 6.1.3. Optional Arguments

Optional arguments are shown using square brackets:

```
cfx5export -cgns [-verbose] file
```

Here the argument `-verbose` is optional, but you must specify a suitable file name.

### 6.1.4. Long Commands

Commands that are too long to display on a printed page are shown with “\" characters at the ends of intermediate lines:

```
cfx5export -cgns [-boundary] [-corrected] [-C] \
[-domain <number>] [-geometry] [-help] [-name <file>] \
[-summary] [-timestep <number>] [-user <level>] [-norotate] \
[-boundaries-as-nodes|-boundaries-as-faces] [-verbose] file
```

On a UNIX system, you may type the “\" characters, pressing **Enter** after each. However, on a Windows machine you must enter the whole command without the “\" characters; continue typing if the command is too long to fit in the command prompt window and press **Enter** only at the end of the complete command.
6.1.5. Operating System Names

When we refer to objects that depend on the type of system being used, we will use one of the following symbols in the text:

<os> refers to the short form of the name which CFX uses to identify the operating system in question. <os> will generally be used for directory names where the contents of the directory depend on the operating system but do not depend on the release of the operating system or on the processor type. Wherever you see <os> in the text you should substitute with the operating system name. The correct value can be determined by running:

<CFXROOT>/bin/cfx5info -os

<arch> refers to the long form of the name that CFX uses to identify the system architecture in question. <arch> will generally be used for directory names where the contents of the directory depend on the operating system and on the release of the operating system or the processor type. Wherever you see <arch> in the text you should substitute the appropriate value for your system, which can be determined by running the command:

<CFXROOT>/bin/cfx5info -arch

6.2. Accessing Help

You can access the ANSYS CFX help in the following ways:

• Select the appropriate command from the Help menu of the ANSYS CFX Launcher or CFX-Pre, CFX-Solver Manager, or CFD-Post. The help will open in the ANSYS Help Viewer.

• Click a feature of the ANSYS CFX interface to make it active and, with the mouse pointer over the feature, press the F1 key for context-sensitive help (that is, the help opens at the appropriate page for the feature under the mouse pointer). Not every area of the interface supports context-sensitive help.

• To access documentation files on the ANSYS Customer Portal, go to http://support.ansys.com/documentation.

PDF help is available in the ANSYS Customer Portal (support.ansys.com/docdownloads).

For information on using the ANSYS Help Viewer, see Using Help in the Using Help.

For further information about tutorials and documentation on the ANSYS Customer Portal, go to http://support.ansys.com/docinfo.

The following table lists the pdf files available for ANSYS CFX:

<table>
<thead>
<tr>
<th>Book</th>
<th>Description</th>
<th>PDF Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSYS CFX Introduction</td>
<td>An overview of CFD and the CFX software</td>
<td>cfx_intr.pdf</td>
</tr>
<tr>
<td>ANSYS CFX-Pre User’s Guide</td>
<td>How to use ANSYS CFX-Pre, the preprocessor for ANSYS CFX</td>
<td>cfx_pre.pdf</td>
</tr>
<tr>
<td>ANSYS CFX-Solver Manager User’s Guide</td>
<td>How to use the CFX-Solver Manager to control a CFD simulation</td>
<td>cfx_solv.pdf</td>
</tr>
</tbody>
</table>
6.3. Using the Search Feature

Selecting Search from the menu bar of the help viewer enables you to perform searches through the online help.

For information on the ANSYS Help Viewer search function, see Using Help: Searching in the Using Help section.
Chapter 7: Contact Information

Technical Support for ANSYS, Inc. products is provided either by ANSYS, Inc. directly or by one of our certified ANSYS Support Providers. Please check with the ANSYS Support Coordinator (ASC) at your company to determine who provides support for your company, or go to www.ansys.com and select Contact ANSYS > Contacts and Locations.

If your support is provided by ANSYS, Inc. directly, Technical Support can be accessed quickly and efficiently from the ANSYS Customer Portal, which is available from the ANSYS Website (www.ansys.com) under Support > Customer Portal. The direct URL is: support.ansys.com.

One of the many useful features of the Customer Portal is the Knowledge Resources Search, which can be found on the Home page of the Customer Portal.

Systems and installation Knowledge Resources are easily accessible via the Customer Portal by using the following keywords in the search box: Systems/Installation. These Knowledge Resources provide solutions and guidance on how to resolve installation and licensing issues quickly.

NORTH AMERICA

All ANSYS, Inc. Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Toll-Free Telephone: 1.800.711.7199
Fax: 1.724.514.5096

Support for University customers is provided only through the ANSYS Customer Portal.

GERMANY

ANSYS Mechanical Products

Telephone: +49 (0) 8092 7005-55 (CADFEM)
Email: support@cadfem.de

All ANSYS Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

National Toll-Free Telephone:

German language: 0800 181 8499
English language: 0800 181 1565
Austria: 0800 297 835
Switzerland: 0800 546 318

International Telephone:

German language: +49 6151 152 9981
English language: +49 6151 152 9982
Email: support-germany@ansys.com
UNITED KINGDOM

All ANSYS, Inc. Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Telephone: Please have your Customer or Contact ID ready.
UK: 0800 048 0462
Republic of Ireland: 1800 065 6642
Outside UK: +44 1235 420130
Email: support-uk@ansys.com
Support for University customers is provided only through the ANSYS Customer Portal.

JAPAN

CFX, ICEM CFD and Mechanical Products
Telephone: +81-3-5324-8333
Fax: +81-3-5324-7308
Email:
CFX: japan-cfx-support@ansys.com;
Mechanical: japan-ansys-support@ansys.com

Fluent Products
Telephone: +81-3-5324-7305
Email:
Fluent: japan-fluent-support@ansys.com;
Polyflow: japan-polyflow-support@ansys.com;
FfC: japan-ffc-support@ansys.com;
FloWizard: japan-flowizard-support@ansys.com

Icepak
Telephone: +81-3-5324-7444
Email: japan-icepak-support@ansys.com

Licensing and Installation
Email: japan-license-support@ansys.com

INDIA

All ANSYS, Inc. Products

Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.

Telephone: +91 1 800 209 3475 (toll free) or +91 20 6654 3000 (toll)
Fax: +91 80 6772 2600
Email:
FEA products: feasup-india@ansys.com;
CFD products: cfdsup-india@ansys.com;
Ansoft products: ansoftsup-india@ansys.com;
FRANCE
All ANSYS, Inc. Products
Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.
Toll-Free Telephone: +33 (0) 800 919 225 Toll Number: +33 (0) 170 489 087
Email: support-france@ansys.com
Support for University customers is provided only through the ANSYS Customer Portal.

BELGIUM
All ANSYS Products
Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.
Telephone: +32 (0) 10 45 28 61
Email: support-belgium@ansys.com
Support for University customers is provided only through the ANSYS Customer Portal.

SWEDEN
All ANSYS Products
Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.
Telephone: +44 (0) 870 142 0300
Email: support-sweden@ansys.com
Support for University customers is provided only through the ANSYS Customer Portal.

SPAIN and PORTUGAL
All ANSYS Products
Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.
Telephone: +34 900 933 407 (Spain), +351 800 880 513 (Portugal)
Email: support-spain@ansys.com, support-portugal@ansys.com
Support for University customers is provided only through the ANSYS Customer Portal.

ITALY
All ANSYS Products
Web: Go to the ANSYS Customer Portal (http://support.ansys.com) and select the appropriate option.
Telephone: +39 02 89013378
Email: support-italy@ansys.com
Support for University customers is provided only through the ANSYS Customer Portal.
Index

Symbols
2-way FSI error
   working around, 28

A
ANSYS CFX
   accessing Design Exploration, 35
   commands, 12
   customizing, 15
   data flow in, 7
   directory structure, 10
   environment variables, 18
   file types, 11
   overview, 7
   running, 9
   starting components from the command line, 12
ANSYS Workbench
   CFX use in, 21
   Files view, 28
   interface, 21
   Project Schematic, 23
   Properties view, 25
   shortcuts, 29
   Sidebar Help, 29
   tips on using, 45
   Toolbox, 22
   tutorials, 45
   view bar, 24
   workflow, 31
   workspace tabs, 24
ANSYSLI_SERVERS
   sets location of license file or daemon, 18
ANSYSLMD_LICENSE_FILE
   sets location of license file or daemon, 17
archiving ANSYS CFX projects, 42
auto-initialise, 54
   (see also auto-initialize)

B
bibliography
   further general reading, 5
browser environment variable, 17

C
cell properties, 25
CFD (Computational Fluid Dynamics)
   applications, 2
   definition, 1
   history of, 1
   mathematics of, 1
   methodology, 2
   solving problems in, 5
CFD-Post, 9
   overview, 9
   cfdpost, 12
   CFX-Solver
      overview, 8
   CFX-Solver input file
      compressed, 17
      formatted, 17
   CFX-Solver Manager, 9
      overview, 9
cfx5, 12
CFXS BROWSER
   sets default file viewer, 17
CFX5EDITOR
   sets default file editor, 17
cfx5info
   provides system information, 13
cfx5launch
   starts ANSYS CFX Launcher, 12
cfx5pre, 12
cfx5solve, 12
CFX5TERM
   sets default terminal emulator, 17
CFX_FORMAT
   sets format of results and CFX-Solver input files, 17
CFX_IMPORT_EXEC
   sets volume mesh import executable, 17
cfxrc file
   syntax, 16
Clear Execution Control, 30
colour map, 53
   (see also color map)
colour mode, 53
   (see also color mode)
colour scale, 53
   (see also color scale)
colour tab, 53
   (see also color tab)
comma vs. period
   not valid as a decimal separator, 10
command line
   starting components from, 12
command line environment variable, 17
configuration file
   syntax, 16
configuration files, 15
control
   volume, 2
   convergence, 5
coupled solver, 9
customisation, 54
  (see also customization)
customise, 54
  (see also customize)

D
decimal separator
  only a period is allowed, 10
Design Exploration
  interface to ANSYS CFX, 35
  using in ANSYS CFX, 35
directory structure
  for ANSYS CFX, 10
documentation, 53
domain initialisation, 54
  (see also domain initialization)

E
deditor environment variable, 17
environment variables, 18
  setting, 18

F
file types
  in ANSYS CFX, 11
finite volume method, 1

G
geometry
  creating, 4
global initialisation, 54
  (see also global initialization)

H
help, 53
  accessing, 55
help viewer
  searching, 56

I
initialisation tab, 54
  (see also initialization tab)
initialise, 54
  (see also initialize)
initialise all components, 54
  (see also initialize all components)

L
launcher
  starting, 19
using, 19
linearisation, 54
  (see also linearization)
linearise, 54
  (see also linearize)

M
mesh
  creating, 4
model
  defining the physics of, 4

N
Navier-Stokes equations, 1

O
online help, 53
  accessing, 55
oxidisation, 54
  (see also oxidization)
oxidise, 54
  (see also oxidize)
oxidiser, 54
  (see also oxidizer)

P
physics
  defining, 4
post-processor, 5
  visualizing results with, 5
Project Schematic, 23

R
residual, 5
resource configuration file
  syntax, 16
resource configuration files, 15

S
Save Settings, 30
scalar variables, 5
SHLIB_PATH
  sets library search path on HP-UX, 18
Sidebar Help, 29
solver
  coupled, 9
synchronise camera, 54
  (see also synchronize camera)
syntax
  for named objects, 10
system information
  obtaining with cfx5info, 13
T
Turbo initialisation, 54
   (see also Turbo initialization)

U
undefined colour, 54
   (see also undefined color)
uninitialise, 54
   (see also uninitialize)

W
working directory
   setting in Workbench, 32